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Editorial
Better late than never, welcome to the 43rd 
issue of 2DArtist! We’re really sorry for 
the delay this month. One word: Siggraph. 
So much to do, so little time … If you’re at 
Siggraph this year, drop by booth #3719 to 
meet Tom Greenway from the 3DTotal/2DArtist 
team, and hopefully if you time it right you’ll 
also be able to meet some artists who are 

featured in our latest book, Digital Art Masters: Volume 4, who’ll be doing 
some book signings! 

Well, it’s halfway through the year already so we thought we’d celebrate 
the halfway point by kicking off some brand new tutorial series’! We’ve 
packed the first parts of three new tutorial series into this July issue, 
starting off with a series aimed to teach the power of 3D in 2D painting, 
showing you how to create depth and achieve a sense of scale easily 
in your paintings by utilising the free and easy-to-use software, Google 
SketchUp. So don’t be afraid of the third dimension, simply check out p.64 
to see just how easy it is to apply 3D geometry to your 2D paintings to get 
some rather impressive results! 

Our second new tutorial series begins with Darren Yeow, full-time 
concept artist in Melbourne, Australia, who introduces us to Dynamic 
Characters: Enhancing your Character Concepts. We wanted to put 
together a series not alike your usual anatomy teachings, but something 
a little more special and focused on helping you to achieve the very best 
of your characters. We’ve therefore asked industry professionals to take 
us through several stages of character creation. In this first part we look at 
thumbnailing (p.88).

Our other new series for July is one that we hope will be useful to those of 
us who browse 2DArtist and can only dream of understanding Photoshop 
like a pro. Well, wish no further: we have Photoshop guru, Nykolai 
Aleksander on hand to teach us how to start painting in Photoshop from 
scratch, taking us through the tools and techniques we need to know to 
get started. I’m pretty sure this in-depth series will also teach some of our 
hardened readers a thing or two as well, and if you’ve ever seen any of 
Nykolai’s stunning paintings at high resolution then you will understand 
why the setting up of your Photoshop before you even start to paint is 
so important. So follow Nykolai’s handy guide to painting like an industry 
professional. We start off by looking at graphics tablets and brush 
dynamics on p.96.

We interview two talented artists this month: Nicholas Miles, insect-loving 
concept artist based in the UK (p.6), and Viktor Titov, hamster-inspired 
concept artist and illustrator from Russia (p.23). Both are featured in 
Digital Art Masters: Volume 4, and when we stumble across talents as 
great as these we just want to know more, more, more! So join us as 
we learn all about Nick’s Insect Dynasty, and how Viktor plans world 
domination through outsource company, Grafit LLC! 

Our making ofs this month feature the exclusive making of Aretha Franklin 
by Jason Seiler (p.106), Yang Xueguo welcomes us to his world with a 
walkthrough his painting, Concrete 7 (be sure to check out his free brush 
set!) (p.114), and Alex Heath teaches us how to recycle while we paint 
(p.120).
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Well, I will leave you to enjoy your magazine with what July has left to 
offer. We’ll be back in full swing next month with more great stuff and yet 
another new tutorial series for you. Till then, stay creative! Ed.

http://www.2dartistmag.com


Setting up your PDF reader 
For optimum viewing of the magazine it is recommended that you have 

the latest Acrobat Reader installed.  

You can download it for free here:  DOWNLOAD!   

To view the many double-page spreads featured in 2DArtist magazine, 

you can set the reader to display ‘two-up’, which will show double-

page spreads as one large landscape image: 

   

1. Open the magazine in Reader;   

2. Go to the View menu, then Page display;  

3. Select Two-up Continuous, making sure that Show Cover 
Page is also selected.

Get the most out of your 

Magazine!
If you’re having problems viewing the double-page spreads that we 

feature in this magazine, follow this handy little guide on how to set 

up your PDF reader!

http://www.adobe.com/products/acrobat/readstep2.html
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Contributing Artists
Every month, many artists around the world contribute to 3DCreative and 

2DArtist magazines. Here you can find out all about them. If you would 

like to be a part of 3DCreative or 2DArtist Magazines, please contact: 

lynette@3dtotal.com

Richard 
Tilbury

Has had a passion for drawing 

since being a couple of feet 

tall. He studied fine art and was 

eventually led into the realm 

of computers several years ago. His brushes have 

slowly been dissolving in white spirit since the late 

90s, and now his graphics tablet has become their 

successor. He still sketches regularly and balances 

his time between 2D & 3D – although drawing will 

always be closest to his heart.

http://www.richardtilburyart.com

ibex80@hotmail.com

Darren
Yeow
27-year old self-taught 

illustrator, originally hailing 

from Adelaide, has worked as 

a concept artist, user interface 

designer and art director in video game companies 

for the past four years, and currently lives in 

Melbourne. Outside his full-time role as an in-house 

concept artist working on next-gen games, he tutors 

hopeful young artists, works on commissioned 

freelance projects, and is writing a book for those 

wishing to pursue a career in concept art.

darren@stylus-monkey.com

Jason  
Seiler

Has had the pleasure of 

painting for many magazines, 

such as TIME and MAD. 

He’s also worked on films for 

Universal Pictures, and more. He teaches a course 

on caricature illustration for Schoolism.com, and 

last year his first book came out, called “Caricature, 

the Art of Jason Seiler”. His second book, “Seiler 

2008-2009” will be available this July, as well as a 

two-hour instructional DVD, “Sketching with Jason 

Seiler”.  

http://www.jasonseiler.com   |   jseiler@jpusa.org

Nicholas
Miles
Working as a concept artist in 

the games industry, and has 

been for roughly four years 

now, whilst developing his 

digital painting skills in his own time, focusing on 

sci-fi and fantasy and his personal projects, ‘The 

Insect Dynasty’ and ‘Exula’. He also likes to write and 

sculpt, to add a little variation to the mix! 

http://www.theinsectdynasty.com  

http://www.exula.co.uk/

http://www.nicksdesk.co.uk

nicholasmiles@gmail.com

Alex
Heath

22-year old artist from England, 

Alex has been fascinated with 

all things sci-fi since he first 

saw Aliens as a child. Since 

then he has been working hard to improve his skills 

to get into the concept art industry, so he can create 

his own monsters, characters and environments for 

gamers to enjoy. Currently freelance, Alex is looking 

for work experience within the industry.

 

 

heath.himself@gmail.com

http://www.2dartistmag.com
mailto:lynette@3dtotal.com
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mailto:darren@stylus-monkey.com
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http://www.theinsectdynasty.com
http://www.exula.co.uk
http://www.nicksdesk.co.uk
mailto:nicholasmiles@gmail.com
mailto:heath.himself@gmail.com
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Yang
Xueguo
From China, Yang always liked 

painting as a young boy and 

is now an art teacher working 

with 3D animation and digital 

painting. Surreal art and digital painting in his city 

is an unusual thing, but he loves it very much and 

always does it for himself. Most of his ideas come 

from life and feelings; he uses different things to 

express the world that he lives in. He simply wants to 

touch people’s hearts with his honest art. 

http://hi.baidu.com/blur1977

blur1977@126.com

Alex “Rhino” 
Voroshev

Works in the videogames 

industry as a concept artist, 

currently senior artist at 

Astrum Online specialising 

in characters, environment and monsters (he has 

a particular liking for the latter). In his work he 

uses Photoshop and Painter, as well as traditional 

materials. He enjoys creating new worlds and 

populating them with unique creatures. 

http://www.voroshev.com 

http://www.mechanicalartist.blogspot.com/

rhino.alex@gmail.com

Robin  
Olausson 

24-years old from south 

Sweden, currently a student 

at the school of future 

entertainment in Karlshamn, 

and working as a freelance concept artist. He’s 

currently looking for an in-house position anywhere 

around the globe. He’s been freelancing for 2-3 years 

for different companies and is also familiar working 

with 3D applications, such as Maya and ZBrush. 

 

http://www.robinolausson.com  

tv1000@spray.se

Rosa 
Hughes

Can peel mandarins really fast, 

kick a hackysack 32 times, 

and animates for a living. She 

currently lives in Brisbane, 

Australia where she works for a pokies company, 

leaving little bits of her soul behind in a shower of 

sparkling gold and glittering teeth. One day she 

hopes to finish all of the projects she’s started over 

her 23 years. 

  

http://www.rosatron.com/

rosatron@gmail.com

Nykolai 
Aleksander
Born in Germany in 1978, she 

moved to England in 1999, 

and currently lives in South 

Africa with her husband. She’s 

been painting digitally since 2002, and works as 

a freelance illustrator for both private clients and 

companies. 

 

 

http://www.admemento.com 

x@admemento.com

Would You Like To Contribute To 
3DCreative Or 2DArtist Magazines?

We are always looking for tutorial artists, gallery submissions, potential 

interviewees, ‘making of’ writers, and more. For more information, please 

send a link to your work to: lynette@3dtotal.com

http://www.2dartistmag.com
http://www.3dcreativemag.com
http://hi.baidu.com/blur1977
mailto:blur1977@126.com
http://www.voroshev.com
http://www.mechanicalartist.blogspot.com
mailto:rhino.alex@gmail.com
http://www.robinolausson.com
mailto:tv1000@spray.se
http://www.rosatron.com
mailto:rosatron@gmail.com
http://www.admemento.com
mailto:x@admemento.com
mailto:lynette@3dtotal.com


In the words of a colleague, Nick Miles is “a 

talented guy”. Working as a concept artist for 

Blitz Games in the UK, he still somehow finds 

the time to pursue his world-building project The 

Insect Dynasty. We recently got the chance to 

sit down with Nick and find out just what this 

project is all about, and what it is about insects 

that he finds so fascinating.

“There’s something 
hugely liberating in 
knowing that by planning 
your goals and putting the 
hours in you can pretty 
much go as far as your 
desires can take you.”



page 7www.2dartistmag.com Issue 043 July 2009

Nicholas Miles Interview

Hey Nick – welcome to the pages of 2DArtist! 

Now if I’ve got my facts right, you’re a UK-

based, games concept artist, who’s been 

working in the industry for the last three years. 

You’ve worked on titles from the Spongebob 

Squarepants series, as well as producing a 

real mixture of fantastic personal pieces, one 

of which is featuring in our very own Digital Art 

Masters: Volume 4! So I guess what I’d like to 

know is how you came to be where you are 

today. Did you just wake up one morning and 

decide you wanted to be an artist? 

Hey Jo. Like a lot of kids, I loved to draw. 

I remember smothering the kitchen floor in 

paintings as a kid. Unknowingly my mum 

would wander into this minefield of hastily 

painted pictures. The not quite dry sheets of 

printer paper would stick to her shoes and 

consequently I’d find myself in a spot of bother. 

Probably one of the few times where being 

artistic didn’t do me any favours!

I didn’t set out to become an artist; in hindsight 

I can see now that I did spend a lot of time 

on creative endeavours, but I think it was just 

something I did and over time it found me. The 

more time I spent focused on my art the more 

my passion for exploring creative avenues grew 

until one day I realised that I couldn’t see myself 

doing anything else in my life. 

I gather that you’re a predominantly self-taught 

artist. What do you think are the advantages 

and disadvantages to such a position? And just 

how do you go about teaching yourself how to 

be an artist? I would imagine it requires a lot of 

practice and patience!

I’ve been focused on developing my illustration 

and concept skills ever since I left University. 

However, illustration was not initially my chosen 

field. Whilst I enrolled in an Art Foundation 

course like many students, my chosen field was 

Product Design before moving onto Graphic 

Design which I carried on into University. I think 

originally I was torn between following my heart 

and getting a “real job” which is a term you hear 

a lot when you’re a student! 

I then realised that your life is a long time to do 

something you don’t enjoy and that I wanted 

to wake up everyday looking forward to the 

“Your life is a long time to do 
something you don’t enjoy”

http://www.2dartistmag.com
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creative challenges ahead, so I completely 

shifted gears and focused on what I would 

need to become a concept artist. Though I had 

a basic level of illustrative skill and a fleeting 

knowledge of applications like Photoshop, I 

knew I’d have to be a lot better, so I knuckled 

down and set myself to task.

Starting out I found a number of online art 

forums; these were incredibly inspiring and 

hugely humbling all at the same time. Through 

seeing the art of professional concept artists 

and freelance illustrators, I could see how high 

the quality bar was set and so establish the 

criteria I would need to meet in order to become 

a concept artist.

The first year after university is an exciting time, 

but also an uncertain one. I quickly developed 

a support network; I talked to artists online, 

learned from their experiences, picked up advice 

on working practices where I could and applied 

them at every opportunity. I learnt a lot over 

that first year by networking and just putting the 

hours into developing my drawing and painting 

skills. It’s daunting to think that after education 

you’re totally in control of your own future, but 

then there’s something hugely liberating in 

knowing that by planning your goals and putting 

the hours in you can pretty much go as far as 

your desires can take you.

I think being self taught allows you the latitude 

to explore and develop your own style without 

being so heavily influenced by those around 

you that you start to lose some of that personal 

flair before it’s had the chance to surface. At the 

same time though, there isn’t the support there 

that you’d find on a specialised course where 

everyone is working towards a similar goal. 

You need to be very motivated as no one else 

is going to do that for you. Specialised courses 

“The first year after university 
is an exciting time, but also an 

uncertain one”

http://www.2dartistmag.com
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will often help you establish links with the industry, but if you’re self taught 

you’re going to have to do that yourself, so networking skills are especially 

important.

I think all of us here at 3DTotal can empathise with that “I should get a 

proper job” feeling! Launching yourself into the artistic industry isn’t a 

move for the faint hearted and I imagine that every artist has gone through 

a few uncertain times during their career. So what was your first proper 

artistic job? And as a self-taught artist, was it hard to get or did you find 

that you were judged more on your artistic ability than what degree you 

studied at university?

My first taste of the industry came in the form of storyboarding for indie 

filmmaking collectives in the UK. I was eager for the experience and it was 

a good insight into what it would be like to work alongside producers and 

hone someone else’s vision into something slightly less nebulous than the 

usual mental meanderings! It was great experience and it was through 

building up these contacts and various storyboarding projects that I was 

able to make a move into the games industry. 

I found my way to Blitz Games Studios and applied for the role of Concept 

Artist. Despite the fact I was very much a rookie, all the work I’d done 

in the previous year, including the work as a storyboard artist, helped 

to prove that I was dedicated to becoming a concept artist. I think I was 

very fortunate to come across a guy (who would later become my Art 

Manager) who was willing to take a chance on a graduate such as myself 

and give them a chance to prove themselves. Personally I think a lot of 

opportunities that are offered to us in any area of the creative industry 

http://www.2dartistmag.com
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arise through 40% talent and 60% perseverance. Like everyone, when 

I was starting out there were a lot of dead ends; a lot of polite rejection 

letters. I just kept at it, worked harder, pushed through the uncertain times 

and I think it’s this dogged determination that helped me get where I am.

Now I just have to ask you about The Insect Dynasty, because I’ve seen 

some of the artwork for it and quite frankly, it looks amazing! For those 

uninitiated out there, could you just give us a quick overview of what this 

project is all about?

The Insect Dynasty was spawned from the first Mantis Queen portrait. 

Initially it was not my intention to form a larger brief from this portrait, 

but as I continued to paint I found myself wondering about her back-

story: what kind of world she lived in; her experiences as a ruler; the 

expectations placed upon her. Very quickly I realised I had the makings of 

a wildly dynamic world, which I called The Insect Dynasty.

My intention is to tell the story of these characters. To describe a world of 

great beauty where tenuous alliances between wildly exotic beings are in 

a constant state of flux and where the slow, relentless grind of conflict is 

so ensconced amongst certain members of the Dynasty that they know 

nothing else. This is a world of contrasts, where highly ordered hierarchies 

clash with turbulent tribes. As the factions shift and vie for power they are 

all slowly falling under the influence of another force, something they will 

come to know as the Gloaming.

“I get into a cold sweat if I’m away from a Wacom 
tablet for more than an hour”

http://www.2dartistmag.com
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you done much writing on this kind of scale 

before? And how is the novel progressing? Is 

a fully-illustrated version of The Insect Dynasty 

saga going to hit the shelves any time in the 

near future? (If so I’d love to buy one!)

[Laughs] Yeah, I get into a cold sweat if I’m 

away from a Wacom tablet for more than an 

hour! There is definitely a lot of work involved 

and just when you think you couldn’t cram 

anymore into a working day, you find there’s a 

whole other level of “busy” that makes the old 

you look like a complete slacker.

Initially The Insect Dynasty will come to life 

through my paintings, but in the background 

I’m writing the novel to compliment and enrich 

the art, which I hope to publish in some form 

late next year. The website (http://www.

theinsectdynasty.com) will go online this July 

and I’ll continue to expand this site as the story 

approaches completion.

Wow – not only content with creating an entire 

world, but you’re also writing a novel! You’re 

obviously not afraid of hard work [Laughs]. Have 

This is my first large scale writing project. I think 

my time as a storyboard artist has given me 

a good sense of how to pace a story and my 

partner Sally is an English teacher, so hopefully 

she’ll pick me up on some of my quirkier 

grammar!

The Insect Dynasty is currently in pre-

production. I’ve been busy establishing the 

different races, such as the Mantids and 

Beetles. By laying out the groundwork I can get 

a good feel for how each society functions, how 

http://www.2dartistmag.com
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their hierarchies flow and what is expected of 

each member of that society. It’s great fun and 

very insightful to place yourself, for example, in 

the shoes of a Beetle Soldier and run through 

what a day in their life would be like.

The aim is to compile a sort of fact file for each 

race to establish their mindsets, their strengths 

and, more interestingly, their weaknesses. This 

will help me to achieve an intuitive feel for how 

each race will deal with the problems they will 

face. The goal is to take this framework and 

apply it to the main story arc in such a way that 

it assists the narrative but isn’t so meticulous 

that it starts to restrict the flow of the storyline, 

as these things invariably take on a life of their 

own. The initial draft will take shape in the 

second half of this year and I’ll take it from there.

What’s your typical working process for creating 

one of your Insect Dynasty characters, from 

start to finish? And do you start with a sketch 

and then just see where your imagination 

takes you, or now that the project has been 

established, do you already have a clear 

idea about the characters’ appearances and 

background before you put your digital paint 

onto the canvas? 

I use a lot of the tried and tested techniques, 

such as silhouette generation. Another route 

is taking a canvas, applying abstract forms 

and seeking out characters from this chaos 

of brush strokes. There’s also a lot of rough 

pencil sketches involved. Often I will apply all 

these techniques in the creation of a singular 

character.

The random form generation is great for 

establishing routes of exploration that you might 

not have initially considered. These can then be 

taken back and used for the basis of silhouette 

generation and then I can add more clarity to the 

design by sketching out these forms in pencil. 

From there I might then overlay more of the 

random shape generation processes to push the 

design further.

http://www.2dartistmag.com
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The basic rules for the look of The Insect 

Dynasty have been laid down. For example, the 

Mantids stand from about 6 to 12ft in height and 

rely more on their speed and agility than brute 

strength. They share more physical traits with 

humans than the formidable Beetles. These 

guys loom larger still and, as you can imagine, 

rely on their strength and heavy armour to carry 

them to their goal. There are others, like the 

Butterfly Assassin, who are only about 12 inches 

in height, so they have a real challenge in 

holding their own against these other formidable 

races. By having a basic rule set I can ensure 

that the races have enough consistent visual 

cues to make them a cohesive whole, whilst 

also coexisting with the other races to make this 

world as believable as possible. 

Seeing as they provide the backbone for your 

whole project, I just have to ask: what is it about 

insects that you find so inspiring?

One of the skills needed as a concept artist 

is to make your designs fit as coherently and 

believably into the given brief as possible, which 

entails thorough research. The research phase 

is a lot of fun as you’re constantly discovering 

things that push your perceptions of the realms 

of possibility. It doesn’t matter how crazy you 

think your ideas are, there’s a good chance 

nature’s already been there, done that and 

pushed it ten times further then you thought 

possible. This is how I arrived at insects. The 

sheer diversity in size, form, colour, texture, 

function, locomotion and so on is just a visual 

feast; an unending source of inspiration and one 

that for this project I couldn’t resist.

Somewhat ironically though I’m actually a little 

afraid of spiders. I recently purchased a display 

of pinned insects, as hands-on research is 

often invaluable. It does however have a big old 

tarantula in the middle of the display, so when 

it’s not in use I have to keep it on a shelf above 

eye level as shocking myself by catching sight 

“Insects are just a visual feast; an 
unending source of inspiration”

http://www.2dartistmag.com
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of a giant spider every few minutes probably 

wouldn’t do much for my nerves! 

I’m glad I’m not the only one who suffers from 

spider-fear! Now, your Insect Dynasty creations 

aside, I love how character-driven the majority of 

your art is. There’s such a sense of personality 

in each and every piece; I really want to know 

more about the characters and how they came 

to be in the situations that you’ve depicted. 

My particular favourite has to be “Harbinger of 

Kestralis”, which is also a great example of the 

really intense, vibrant, almost fluorescent colour 

that you seem to favour. With all the various 

artistic choices out there, and the different 

directions your artwork could have taken, how 

did you arrive at this particular artistic style?

Colour is one of those things I’ve never been 

afraid to play with. I think all artists have a 

core skill which they can innately feel out; I 

know some who have a real gift for dynamic 

illustration, others for something more specific 

like architecture. I think mine is probably colour. 

People used to comment on how my paintings 

would make their eyeballs bleed! I think over the 

last three or four years, as my understanding 

of the application of light and colour has 

sharpened, I’ve become more adventurous with 

the palettes I choose, giving the images clout 

where needed to help guide the viewer’s eye 

around the composition without resorting to 

putting anyone’s eyeballs under too much strain! 

Paintings like “Harbinger of Kestralis” are there 

to remind me to never lose that playful aspect of 

my palettes, to not be afraid and to sometimes 

just throw down some bold colours and see 

where it leads.

I’m inspired by a great many artists; some are 

on my doorstep while others are in parts of the 

world I have never seen, but they all inspire me 

to push myself further. There’s always more to 

learn, which is one of the reasons why I love 

being an artist.

Aside from The Insect Dynasty, what other 

projects are you working on at the moment? And 

http://www.2dartistmag.com
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do you have anything lined up for the future, or 

is it insects all the way?

During the day I continue my role as a games 

concept artist. The Insect Dynasty will definitely 

take a great deal of my attention through 2009 

and 2010. I have other slow burning projects 

such as Exula which is another world building 

project that I’ll bring to fruition after The Insect 

Dynasty. Exula features a menagerie of human 

and alien characters thrown together in a world 

where the Demi Gods of the past, known as the 

Guardians, are beginning to exert their influence 

once more. The “Harbinger of Kestralis” is 

a painting from the Exula world. I’ve also 

produced album art for the band Left Below and 

there may well be more of that in the future. 

Otherwise I’m just going to keep on indulging my 

passion and keep drawing, writing and sculpting 

whenever I get the chance.

Now just a quick question to finish: if you had to 

name one artist whose work you find particularly 

striking, or who has influenced you in some way, 

then who would it be and why?

Just one you say? Crikey [Laughs]! Well I guess 

I’d have to take it back to grass roots level.

Back in the day when the web was just a series 

of yoghurt pots and taut string, I’d just graduated 

from university and was seeking art collectives 

and the first place I came across was the Flight 

forums run by a guy called Kazu Kibuishi. He’s 

well known for his comic shorts such as Copper 

and his ongoing graphic novel series Amulet, 

much of which can be found on his personal 

website: www.boltcity.com 

Despite the fact he was obviously very busy 

he always took the time to look over the forum 

posts and provide critique and encouragement 

to artists such as myself. I was, and still am, 

drawn in by the wonderment and optimism 

much of his work is imbued with. I feel that the 

narrative drove much of his work and the visuals 

that accompanied it, be it for a comic or a 

one-off painting, always enhanced the narrative 

rather than dictated it. It’s difficult to do his work 

justice so I’ll just say that he continues to be 

a great source of inspiration, both directly and 

indirectly, and he helped to give me the strength 

to forge my own path. I’m very grateful for that! 

Thank you!

By posting work in places such as the Flight 

forums I persisted; I took on board the critique 

I was given and pushed myself to improve. I 

remember reading magazines like 2DArtist and 

wondering what it’d be like to be on those pages 

and now I am - very cool indeed!

And it’s been a pleasure to have you here, Nick. 

Thanks for a great interview and good luck for 

the future!

Nicholas Miles
For more work by this artist please visit:

http://www.exula.co.uk/ 

http://www.theinsectdynasty.com (coming soon)

http://www.nicksdesk.co.uk (coming soon)

Or contact them at:

nicholasmiles@gmail.com 

Interviewed by: Jo Hargreaves

“I was, and still am, drawn in by 
the wonderment and optimism of 

his [Kazu Kibuishi’s] work”

http://www.2dartistmag.com
http://www.boltcity.com 
http://www.exula.co.uk/ 
http://www.theinsectdynasty.com
http://www.nicksdesk.co.uk
mailto:nicholasmiles@gmail.com
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Vancouver Film School alumni credits include Across the Universe Geeta Basantani, 
Digital Compositor Alias Scott Dewis, Visual Effects Artist Babel Luis Blackaller, 
Storyboard Artist | Lon Molnar, Visual Effects Supervisor Battlestar Galactica Daniel 
Osaki, Lead Modeler | Megan Majewski, 3D Animator | Alec McClymont, 3D Artist Bioshock 
2 (VG) Jacob Palmer, Animator  Bolt Lino Di Salvo, Supervising Animator/Voice of 
Vinnie Charlotte’s Web Aruna Inversin, Digital Compositor | Adam Yaniv, Character 
Animator | Tony Etienne, Lead Lighter | Kristin Sedore, Lighter The Chronicles of Narnia: 

Prince Caspian Andreas Hikel, Pre-Visualization Artist | Christoph Schinko, Character 
Animator | Jami Gigot, Senior Layout Artist Cloverfield Nicholas Markel, Pre-Visualization 

Supervisor Constantine Aruna Inversin, Digital Compositor The Dark Knight Pietro Ponti, 
Lead CG Lighting Artist Dead Like Me Daniel Osaki, Visual Effects Artist | Alec McClymont, 3D 

Artist Diablo III Alvaro Buendia, Cinematic Artist | Steven Chen, Cinematic Artist District 9 Neill 
Blomkamp, Director | Shawn Walsh, Visual Effects Executive Producer | Jelmer Boskma, Modeler  

Bernhard Kimbacher, Compositor | Julianna Kolakis, Creature Texture Painter | Adam Marisett, Visual 
Effects Artist | James McPhail, Visual Effects Technical Director | Dominic Cheung, Lighting Technical 
Director | Grant Wilson, Animator | Joey Wilson, Modeler Family Guy Michael Loya, Storyboard Artist 
Fantastic Four: Rise of the Silver Surfer Arun Ram-Mohan, Lighting Technical Director | Shawn 
Walsh, Visual Effects Executive Producer | Jessica Alcorn, Compositor Gears of War (VG) Scott 
Dossett, Animator G.I. Joe: The Rise of Cobra Allen 
Tracy, Visual Effects Editorial Supervisor | Aruna 
Inversin, Digital Compositor Jeremy Stewart, 
Senior Animator | Jelmer Boskma, Modeler The Godfather (VG) Kirk Chantraine, Motion Capture 

Specialist The Golden Compass Adam Yaniv, Animator | Chad Moffitt, Animator | Thom Roberts, 
Animator | Ben Sanders, Animator | Andrew Lawson, Animator | Matthias Lowry, Visual Effects | Tony 

Etienne, Look Development | Justin  Hammond,  Lighter | Pearl Hsu, Effects Technical Director | Aruna Inversin, 
Digital Compositor | Fion Mok, Matchmove Artist Hairspray Lon Molnar, Visual Effects Production Executive 

Halo 3 (VG) Bartek Kujbida, Character Animator Happy Feet Ben Sanders, Character Animator | Thom Roberts, 
Character Animator Harry Potter and the Prisoner of Azkaban Shawn Walsh, Color & Lighting Technical Director 

Harry Potter and the Order of the Phoenix Pietro Ponti, Technical Director Harry Potter and the Half-Blood 
Prince Harry Mukhopadhyay, Lead Effects Technical Director Hellboy II: The Golden Army Christoph Ammann, 3D 

Sequence Supervisor Horton Hears a Who Arun Ram-Mohan, Lighting Technical Director | Brent Wong, Modeler Hulk 
Geoff Richardson, Visual Effects Editor I, Robot Daniel Osaki, CGI Modeler | Megan Majewski, Pre-Visualization Ice Age: 
The Meltdown Ben Sanders, Character Animator | Arun Ram-Mohan, Lighting Technical Director The Incredible Hulk 
Shawn Walsh, Visual Effects Executive Producer | Tony Etienne, Look Development Lead The Incredibles Daniel 

Holland, Animator Indiana Jones and the Kingdom of the Crystal Skull Henri Tan, Creature Technical Director 
Iron Man Adam Marisett, Visual Effects Artist King Kong Chad Moffitt, Senior Animator King of the Hill Michael 

Loya, Director Kingdom Hospital Daniel Osaki, Visual Effects Artist | Megan Majewski, 3D Animator | Alec 
McClymont, 3D Artist Kingdom of Heaven Shawn Walsh, Digital Compositor Left 4 Dead (VG) Nick Maggiore, 
Animator Letters from Iwo Jima Aruna Inversin, Digital Compositor Live Free or Die Hard Jessica Alcorn, 
Compositor Lord of the Rings Trilogy Chad Moffitt, Senior Animator Lost Scott Dewis, Visual Effects Artist 
Mass Effect (VG) Sung-Hun (Ryan) Lim, 3D Modeler Matrix: Revolutions Aruna Inversin, Digital Compositor 
Shawn Walsh, Color & Lighting Technical Director Master & Commander: The Far Side of the World 
Robert Bourgeault, CG Artist Metal Gear Solid 4 (VG) Josh Herrig, Artist | Yuta Shimizu, Artist The Mummy: 
Tomb of the Dragon Emperor Aruna Inversin, Digital Compositor Persepolis Marianne Lebel, Animator 
Pirates of the Caribbean: At World’s End Ben Sanders, Character Animator | Allen Holbrook, Animator 
Aruna Inversin, Digital Compositor The Pirates Who Don’t Do Anything: A VeggieTales Movie Mike 
Dharney, Animation Supervisor Reign of Fire Lino DiSalvo, Animator Resident Evil: Extinction Joshua 
Herrig, Visual Effects Artist Robots Arun Ram-Mohan, Additional Lighting Rome Teh-Wei Yeh, Matchmove 

Artist Scarface (VG) Maya Zuckerman, Mocap 3D Generalist Shrek the Third Rani Naamani, Animator 
Shrek the Third (VG) Samuel Tung, Technical Artist Sin City Michael Cozens, Lead Animator Smallville 

Geeta Basantani, Lead Compositor Star Trek Aruna Inversin, Digital Compositor | Tom Piedmont, 
Digital Plate Restoration Star Wars Episode III: Revenge of the Sith Andrew Doucette, Character 

Animator |  Nicholas Markel, Pre-Visualization Star Wars: Knights of the Old Republic (VG) Arun 
Ram-Mohan, 3D Artist | Jessica Mih, Level Artist Stargate: Atlantis Daniel Osaki, 3D Animator 

Megan Majewski, 3D Animator | Alec McClymont, 3D Artist Sweeney Todd: The Demon Barber 
of Fleet Street Jami Gigot, Concept Artist Terminator Salvation Teh-wei Yeh, Lighting Technical 

Director | Geeta Basantani, Digital Matte Painter Transformers: Revenge of the Fallen Bryan Jones, 
Compositor | Aruna Inversin, Digital Compositor | Henri Tan, Creature Technical Director | Teh-wei Yeh, 

Digital Artist | Stephen King, Animator Twilight Geoffrey Hancock, Digital Effects Supervisor Unreal 
Tournament III (VG) Scott Dossett, Artist Valiant Robert Bourgeault, Lighting Technical Director WALL-E  
Mark Shirra, Layout Artist | Bill Watral, Effects Artist | Daniel Holland, Production Artist Watchmen Lon 

Molnar, Visual Effects Supervisor World of Warcraft: Burning Crusade (VG) Carman Cheung, 
Animator Warhammer 40,000: Dawn of War II (VG) Ian Cumming, Senior Artist | Nathan Hocken, 

Lead Animator A Wrinkle in Time Aruna Inversin, Digital Compositor and many more.

Your name here.

VFS student work by Thiago Martins

http://www.vfs.com/animationvfx


Elves, goblins, knife-throwers, hamsters, dragons, werewolves and 

beautiful women … What more could you ask for? After working with 

Viktor recently on our Digital Art Masters: Volume 4 book project we were 

thrilled when he agreed to an interview so we could get to know more 

about the mind behind the hand that creates such stunning artwork. Or is 

it the artwork that dictates to Viktor what he creates? Decide for yourself – 

read on to find out more about this intriguing artist, and how a recent blow 

to the head has made him rediscover his passion for life.

“You have the feeling that 
it’s not you drawing the 
characters, but that they 

are the ones operating 
your hand and want you 

to paint them 
that way!”
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Hi Viktor, thanks for agreeing to this interview. 

So first of all: hamsters. What’s this all about? I 

go onto your website, www.hamsterfly.com, and 

there I find a flying hamster. This furry friend 

also re-appears in your fantastic image, “Dragon 

Crash” (a personal favourite of ours, I might 

add). So what’s the story behind the hamster…?

Well, I simply love hamsters; they are fluffy, 

strong and noble animals! I had a hamster 

some time ago, he was really cool, and he was 

always grabbing his sword and swinging it all 

around the place. [Laughs] But seriously though, 

I actually thought up the nickname first, and 

then all the stories and pictures about hamsters 

appeared later on.

Ah ok, I was imagining some really weird 

but wonderful tale of hamsters during your 

childhood that led to the inspiration. I have a 

hamster at the moment and he really is a cool 

little dude … but if I gave him a sword he’d 

probably just bite it, then wee on it, and then 

get bored of it. Anyway! Moving on, do you find 

storytelling is a big part of your artwork? Where 

to do you get your inspiration from for most of 

your art projects and stories?

The most interesting thing is that sometimes 

you start to draw on a blank page without any 

ideas, and gradually, with each brushstroke 

the characters become alive. It is very amusing 

because when this happens you have the 

feeling that it’s not you drawing the characters, 

but that they are the ones operating your hand 

and want you to paint them that way!

[Laughs] That has to be one of my favourite 

quotes to date! So you’re living and working in 

Russia as a concept artist and illustrator. How 

did you get into concept art and illustration – did 

you study at an art school or are you self-

taught? Can you give us a little insight into how 

you got into the industry and how you keep on 

your toes?

Like many other artists, I studied art at school 

and then went onto art college. It then turned 

out that my first job was as a 3D character 

animator in a games development company, 

but even then I was still training my art skills at 

home after work. I then became lead animator, 

3D modeller, and then went freelance for a 

while. I finally got a job as a concept artist for 

Nival Online, which is a big Russian game 

development company where I worked for two 

years creating characters for Allods Online, the 

MMORPG with a $12 million budget – which is a 

record for Russian development!

I am now a freelance artist and co-founder of an 

art outsource company which produces all types 

of 2D and 3D graphics, mainly specialising in 

http://www.2dartistmag.com
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illustrations, concept art and 3D models for 

games. We have collected some of the best 

Russian artists in the industry, and we have 

great plans for the future!

Wow, that sounds very exciting; can you tell us 

a little more about this art outsource company? 

How did it come about, and can you tell us 

some of your plans for the future? Can you also 

perhaps spill some of the names of the artists 

you’re working with? We’re nosey like that, you 

see [Laughs]!

Grafit LLC is a young, growing company with 

the big ambitions and plans. Right now we 

have seven 2D artists and two 3D artists in our 

command, but we will continue to grow and train 

our crew as much as possible, considering the 

world economic crisis of course. 

Our main clients are large Russian publishing 

houses and game developers. There are also 

some clients from Europe, the US, and even the 

Chinese companies. All our employees are very 

talented; each has their own style and strength 

in a particular field of art. To name names, 

our artists include Roman Tulinov, Viktoriya 

Anokhina Natalia Gorshkova, Irina Vlasova, 

Andrey Pervukhn, and Lev Boyko.

Sounds fantastic, we look forward to seeing 

more from you all! So back to you Viktor, you 

show a great understanding of colour in your 

portfolio. Do you have any tips that you can 

share with us about how you pack a punch 

using colour in your artwork? We’d love to find 

out a little about your painting process and how 

you decide upon your colour scheme!

It’s very important to be able to understand the 

distribution of light, and some knowledge of the 

laws of physics really helps as well. However, 

the main thing I consider to be important when 

working with colour is intuition; for example, I 

often change the colour scheme in the middle 

of my painting process using adjustment tools 

in Photoshop. I think that for the proper use 

of colour you need experience; you should 

observe the world around you and take note of 

the beauty within it.

“I often change the colour 
scheme in the middle of my 

painting process”

http://www.2dartistmag.com
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Ah, that’s really interesting that you say you’ll 

often change colour scheme mid-painting. What 

are the tools you use to do this for a smooth 

transition? And about taking notice of the 

beauty in the world around you, what has been 

the most amazing thing in nature you’ve seen 

recently that has inspired – or is going to inspire 

– an artwork?

I often use the Curves tool, Hue/Saturation, 

sometimes Color Balance … Someday I will find 

the time to write a tutorial about the tools that I 

use; how to make a good image from a bad one 

by applying some colour correction, texture and 

filters!

So what can I say about inspiration? Well, I 

think it’s a very strange thing to be honest. 

Sometimes it comes from nowhere; you can be 

simply drifting through your usual daily routine, 

and then when you get home in the evening and 

get to your graphics tablet, you can be bloating 

with ideas and the desire to paint! Whereas, 

other times, such as after a day of visiting art 

exhibitions or attending other interesting events, 

you quite simply have no energy left to be 

creative at the end of the day, despite being full 

of ideas. 

I derive inspiration from everywhere, really. 

It’s necessary to celebrate all that is around 

you, and to appreciate every minute of your 

life. I recently had a blow from a falling brick 

to my head – luckily all ended well. But after 

it happened, I began to appreciate the beauty 

of the world around me much more strongly 

[Laughs]!

  

Oh gosh, we’re really pleased to hear you 

survived the falling brick, Viktor! I had a penny 

fall on my head once from a height, and that 

was painful enough, so I can only imagine 

the sheer pain of a falling brick! We hope you 

recovered/are recovering well. So back to 

your artwork: elves, goblins, knife-throwers, 

hamsters, dragons, werewolves and beautiful 

women – your work would certainly fall into the 

fantasy realm. So what is it about fantasy art 

that really gets you going? Are there any others 

areas of art that you like to dabble in? 

It occurred spontaneously, really. In the 

beginning, I worked with various subjects, but 

then over time it worked out that I got some 
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fantasy-style commissions, and that in turn 

generated even more clients wanting work in a 

similar style, and so the vicious cycle began! I 

love other realms as well though, for example 

the sci-fi genre, and I hope to strengthen my 

skills in this area in the foreseeable future.

Sci-fi art, hey – I’d love to see your works on 

this theme! You’ve gone and teased us with that 

now haven’t you? Ok, so let’s talk sci-fi: what do 

you think will be your first art project to tackle 

the sci-fi genre, and where will you seek your 

inspiration from? And on the topic of inspiration, 

which artists do you generally turn to on a day-

by-day basis to help inspire your own art?

Actually I have already worked on one sci-fi 

project in which I made some illustrations for 

Eclipse Phase, a book by InMediaRes Productions, LLC. Hopefully when 

the book is released I can publish the pictures in my portfolio. 

I usually search the different art forums and galleries for inspirational 

pictures, but there are certain artists that have affected me most of all, 

such as Craig Mullins, Gerald Brom and Paul Bonner. At present, I am 

very strongly impressed by the work of Paul Bonner, because he has 

great skill in depicting light and shade in his images. He also makes very 

realistic and charming fantasy characters!

It seems Craig and Brom are amongst the top influences in the industry 

– very popular choices with our interviewees so far! So you seem to get a 

lot of commissions for the likes of book cover art and DVD game covers. 

Can you give us any advice about how to get work in this area? I’m also 

curious: if you could have any commission in the world, what would you 

want it to be, and why?

Well, I simply post my pictures in online galleries and forums – some 

http://www.2dartistmag.com
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of the people that see my works there are, of 

course, my potential customers. It’s very seldom 

that I will need to go out and specifically search 

for work. If you have recognition, you will have 

commissions!

If I could have any commission in the world, I 

would like to do concept artwork for the movies 

– either sci-fi or fantasy.

Is there any recent concept artwork for movies 

that you’ve seen that has made you think, 

“Wow! I really wish I’d been involved in that!” 

And along the same lines, are there any 

movies – past or present – that you’d love the 

opportunity to work for? Would you say that 

working as a concept artist for the movies is 

your future career ambition, or do you have 

other plans?

Oh, I like many movies: The Lord of the 

Rings, Star Wars, The Matrix, The Terminator, 

Pan’s Labyrinth … I like it when a film has its 

own considered visual style. And I’ve always 

wondered how great it would be to make 

concept drawings or storyboards for such 

beautiful films as these. Unfortunately though, 

there are very few films shot in Russia, and films 

with good visual effects are even fewer, so I 

hope for the future to move to a country with an 

advanced film industry. However, I’m still happy 

working here as a freelance illustrator and 

concept artist, too.

Well, we wish you all the best with your career 

aspirations Viktor. Thanks for this interview; 

it’s been great talking to you and also learning 

a little bit more about your career path, your 

artwork and what inspires you. One last 

question and it’s an old favourite of ours: if you 

could offer our readers just one piece of advice 

– and as we’re talking about just one here, we 

mean something really profound [Laughs] – then 

what would it be?

It would be a short piece of advice: be careful 

with your thoughts, because they have a habit of 

coming true. I would also like to say thanks for 

this great experience – it’s been fun answering 

these questions!                                  

You’re welcome Viktor, keep in touch!

Viktor Titov
For more work by this artist please visit:

http://www.hamsterfly.com/ 

http://www.hamsterfly.deviantart.com

Or contact them at:

viktortitov@yahoo.com

Interviewed by: Lynette Clee 

“If you have recognition, you will 
have commissions!”

http://www.2dartistmag.com
http://www.hamsterfly.com/ 
http://www.hamsterfly.deviantart.com
mailto:viktortitov@yahoo.com


Creator of all things nasty that bite and rip and claw and form your gaming enemies, Alex “Rhino” 
Voroshev teaches us a thing or two from his knowledge bank and experience as a lead concept 

artist for games.



Working as a lead concept artist, I create 

concepts of locations, monsters, objects and 

characters. Prior to working on the concept for 

any object, character or location, I always start 

with a dash, silhouette, blur, or just a few strokes 

to give my imagination the impulse to create 

something new. When working on a concept for 

a game I keep in mind the characteristics of the 

Imp
Working on the Imp image, I 

made it my mission to create 

an unconventional concept. 

Having studied several images 

of imps created by other artists 

on the internet, I grasped what 

peculiarities they employed and 

chose to take an alternative 

approach with my own 

interpretation. I didn’t want to depict 

just an ordinary imp; I wanted to 

create an image dissimilar with any 

others I’d seen, providing that my 

design didn’t lose the traditional 

demonic essence of the creature. 

The game concept required a 

creature which gave the impression 

of aggressiveness, but at the same 

time did not provoke much fear. I 

got exactly what I wanted after I 

combined the features of an animal 

and an ape-type man, added some 

horns – which were a must – and 

dressed him up in heavily spiked 

armour. I achieved not a nasty little 

demon, but a cruel hunter from 

some primitive tribe – the perfect 

enemy for any gamer (Fig.01)!

game for which it is being developed. A game 

engine has certain restrictions, and the ultimate 

goal is to create an expressive image which 

will look in game just as intended. For next-gen 

engines I use one approach, and for sprite-

oriented games I come up with quite a different 

one. I need to consider not only different details 

on the objects, but also their size in game. 

Creating a super-detailed sketch for a strategy 

game or an RPG, where your character can 

be seen only from a bird’s-eye view is a mere 

waste of time and effort, and the result would 

not be what was intended. So in this article, 

I’m going to give some recommendations and 

describe my process of working when creating 

concept sketches for games.



Manticora 
This concept was a rather complex character to design as it has a distinctive set of characteristics that are well 

known in myths of this kind, and if you give up on them then you risk making the creature unrecognisable. My 

additions to the traditional interpretation were a muzzle of a predatory ape-man, rather than a human face, 

spikes on the head, tail and paws, and I also invented a pair of odd Trichoplax wings for her (Fig.02). 



Yeti
More often than not, artists depict a yeti as a 

naked ape-man type creature. However, after 

adding a crude weapon, primitive clothing, 

and skull decoration, my yeti became a 

creature which, in my opinion, would blend 

more into the game environment. I felt that 

the clothing, weaponry and other accessories 

that he adorns stir the imagination and 

give the gamer ideas about the culture and 

general lifestyle of these creatures (Fig.03).



Centaur
This centaur is not your average Ancient Greek 

dude with the appearance of a stripper and the 

body of a horse, but rather I took the concept of 

centaur – a man with a horse’s body – just as 

a basis. I replaced the body of a horse with the 

body of a huge cat, added animal fangs and a 

mane to his face, and dressed him in a sort of 

rough armour. In the end he reminded me more 

of a severe Northern warrior – he’s certainly no 

longer a centaur (Fig.04)!



Chimeras
When working on sketches of 

chimeras, such as ghosts and 

demons, I prefer using a dark 

background as it allows me to 

create an image without distracting 

myself with elaborate lighting and 

other details. Also, any gleaming 

objects look much better on darker 

backgrounds (Fig.05a – 05b).





When working on a character or creature 

concept, it is very important not to make the 

image too busy with details (Fig.06a – 06b). 

An image is formed from two-to-three elements 

which shape the character. You don’t need a 

jumbled mass of detail which serves no other 

function than to distract the gamer! This is what 

I consider to be my basic rule. 



Also, I believe that the importance of exploring 

the artworks of other authors cannot be 

overstated. It allows you to find new ideas, 

methods, and helps you to develop and 

accumulate a knowledgebase. Without this 

knowledge, it will be very difficult for you to 

create impressive concept art. 

I wish you the best of luck in your artworks. You 

can check out more of my art and some tutorials 

on my website, and you are welcome to contact 

me by email with any questions. Thanks for 

reading!

Alex “Rhino” Voroshev
For more information please visit:

http://www.voroshev.com

http://www.mechanicalartist.blogspot.com/

Or contact them at:

rhino.alex@gmail.com

http://www.voroshev.com
http://www.mechanicalartist.blogspot.com
mailto:rhino.alex@gmail.com
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Lord Cumbancha
Carlos Cabrera

http://www.carloscabrera.com.ar/

sayhi@carloscabrera.com.ar

Fighter
Andreas Rocha

http://www.andreasrocha.com 

rocha.andreas@gmail.com

Check back in with 2DArtist in the August 2009 

issue for an interview with Carlos Cabrera, and 

don’t miss his custom brushes tutorial next 

month to grab some free brushes and learn how 

to make your own!

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://www.carloscabrera.com.ar/
mailto:sayhi@carloscabrera.com.ar
http://www.andreasrocha.com
mailto:rocha.andreas@gmail.com
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Image Title
Artist Name

Website Address 

Black Hat
Damián Linossi

http://www.odaclick.com

odapuma@hotmail.com

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://www.odaclick.com
mailto:odapuma@hotmail.com
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Garage
Alex Broeckel

http://www.alexbroeckel.com

alexbroeckel@googlemail.com

This image has been created for 2DArtist for the ‘Using 3D as a Base for 2D 

Painting tutorial series that started this month. Check back in with us next month 

to find out how Alex used Google SketchUp and Photoshop to paint this scene!

Stereomastis
Arnaud Valette

http://www.arnaudvalette.com

arnovalette@gmail.com

http://www.2dartistmag.com
mailto:gallery@zoopublishing.com
http://www.alexbroeckel.com
mailto:alexbroeckel@googlemail.com
http://www.arnaudvalette.com
mailto:arnovalette@gmail.com


Image Title
Artist Name

Website Address 

Image Title
Artist Name

Website Address 

Ola
Slava Gedich

hudoznik@mail.ru

mailto:hudoznik@mail.ru


Star Pirates
Ioan Dumitrescu

jononespo@yahoo.com

mailto:jononespo@yahoo.com


Image Title
Artist Name

Website Address 

Demiurgo
Eduardo Peña

http://chino-rino.cgsociety.org/gallery

caareka20@hotmail.com

http://chino-rino.cgsociety.org/gallery
mailto:caareka20@hotmail.com


Image Title
Artist Name

Website Address 

Image Title
Artist Name

Website Address 

Elvis Costello
Jason Seiler

http://www.jasonseiler.com

jseiler@jpusa.org

Check back in with 2DArtist in the October 2009 issue for 

an interview with Jason Seiler, master of the caricature!

http://www.jasonseiler.com
mailto:jseiler@jpusa.org


Hit + Miss
Nykolai Aleksander

http://www.admemento.com/

x@admemento.com

This image has been created as part of an upcoming 

Custom Brushes workshop, to be published in the 

September 2009 issue of 2DArtist with free custom 

brushes for all our readers, so be sure to check back in 

with us for the tutorial in September!

http://www.admemento.com/
mailto:x@admemento.com
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Damien Canderlé�
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John Wu
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Marek Denco

Neil Blevins

Nathaniel West

Matt Dixon 

Buy the book to see just  
how they create their 
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Welcome to the Stylised Challenge! 

Every month we run this challenge, which 

is open for anyone to enter. The challenge 

runs in the conceptart.org forums and 

winners get to choose prizes and goodies 

from the www.3dtotal.com shop! They’re 

also featured in this very magazine, where 

we display the winners from the previous 

month’s challenge, as well as the “Making 

Of’s” from the month before that..

Robots
Stylised Character challenge

http://www.conceptart.org
http://www.3dtotal.com


page 53 Issue 043 July 2009www.2dartistmag.com

Robots Stylised Challenge

The Challenge
Welcome to the Super Stylised Monthly 

Challenge. Each month we select a theme 

and post some images in the Forum Thread 

for reference. All you have to do is to create a 

2D image in line with this theme in a stylised 

/ abstract / cartoon style, whilst keeping your 

image instantly recognisable. We wanted to 

publish some content in 2DArtist magazine on 

how to create stylised images, such as you see 

in the many feature films and cartoon galleries. 

We thought this regular competition might 

bring in just the images and “Making Of’s” that 

we need, whilst giving away great prizes and 

exposure. This month’s theme was “Robots”. 

Here you can see the top placed entries, as 

voted for by the public.

Sean Thurlow - Trashy  
deadite44@hotmail.com

http://trashyworks.blogspot.com/

9th

Nadia Mogilev - Nadiamoon 
nady.design@gmail.com

http://www.nadiamoon.com

9th

Adrian Zhang - Gnahz 
adrian.zhangzhiwei@gmail.com

http://gnahz.deviantart.com/

9th

Justice Von Brandt  
justicevonbrandt@live.com
http://justicevonbrandt.com

9th

8th

Matthew Silber - Dreygus  
strad1138@yahoo.com

http://www.ganarus.wordpress.com

7th What are we looking for?
Funny and humorous entries which break 

the theme down to its most recognisable 

components; emphasise these in whichever 

ways you think best, and render your stylised 

/ abstract / cartoon masterpiece. The rules are 

pretty laid back: please submit 1 x 3D render 

(minor post work is OK); its up to you if you want 

to have a background; include some graphical 

elements or text on your image. Renders of the 

800 pixel dimension sound about right, but the 

winners will be featured in 2DArtist Magazine, 

so if you can create some higher res images too 

then all the better! 

SAmkaa 

http://www.2dartistmag.com
http://www.conceptart.org/forums/forumdisplay.php?f=74
mailto:deadite44@hotmail.com
http://trashyworks.blogspot.com/
mailto:nady.design@gmail.com
http://www.nadiamoon.com
mailto:adrian.zhangzhiwei@gmail.com
http://gnahz.deviantart.com/
mailto:justicevonbrandt@live.com
http://justicevonbrandt.com
mailto:strad1138@yahoo.com
http://www.ganarus.wordpress.com
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Ray Williams - Artiphats  
art1phat@hotmail.com

http://raysartonline.com/

5th

Email
Website

4th

Arturo Aguirre - Artina 
artinastudio@gmail.com

http://artinastudio.blogspot.com

3rd

Tsolmonbayar Batbaatar - GRMC  
grmcx_xac@yahoo.com

6th

Monstertree

http://www.2dartistmag.com
mailto:art1phat@hotmail.com
http://raysartonline.com/
mailto:artinastudio@gmail.com
http://artinastudio.blogspot.com
mailto:grmcx_xac@yahoo.com
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János Kiss - 28th Wing 
janos.kiss@28thwing.com
http://www.28thwing.com

There will be one competition per month, 

with the deadline being the end of the month 

(GMT). For a valid entry, just make sure your 

final image is posted in the main competition 

thread before the deadline. We require the top 

three winners to submit “Making Of” overview 

articles that will be shown on either 3DTotal 

or in 2DArtist Magazine. These need to show 

the stages of your creation - different elements 

and some brief explanation text - of why, and 

how, you did what you did. We will format 

this into some nice-looking pages to give you 

some great exposure, and us some quality 

content. Each competition will have one main 

thread which starts with the brief at the top. All 

entrants should post all WIP’s, give feedback 

and generally laugh at the crazy ideas that are 

emerging each month...

Challenge Thread
The entire Robot competition can be viewed 

Here

 

The current challenge at the voting stage is: 

Amazon Woman Warrior

                

To join the next challenge, or to view previous, 

and / or current entries, please visit: www.

conceptart.org    

Or contact: Lynette@3dtotal.com

2nd

Richard G.D. Baker - The Antarctican 
cirqus@cirqus.com

http://www.cirqus.com

1st

http://www.2dartistmag.com
mailto:janos.kiss@28thwing.com
http://www.28thwing.com
http://www.conceptart.org/forums/showthread.php?t=143234
http://www.conceptart.org/forums/forumdisplay.php?f=74
http://www.conceptart.org/forums/forumdisplay.php?f=74
mailto:lynette@3dtotal.com
mailto:cirqus@cirqus.com
http://www.cirqus.com
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Making Of’s
Here are the “Making Of’s” from last month’s top 

three winning entries...

3rd Rvdtor
Software Used: Photoshop

Well this is my third time participating in the 

Super Stylised Challenge on ConceptArt.org. 

Just a little introduction: my name is Arvid 

Torres and I’m from Belize in Central America. 

While studying at art school, currently doing 

multimedia and animation art, I decided to take 

it upon myself to study digital painting and 

illustration on my own. Anyway, this was my 

third attempt at the stylised challenge – the 

first two being the Centaur and my unfinished 

Bigfoot. And now I have the chance to write a 

making of for the Jester!

My normal way of sketching and rendering is 

to do very rough sketches, and then below that 

add the black and white values very roughly. On 

another layer above those two I then refine the 

shadows and values in black and white before I 

proceed to add colour. However, I like to look at 

these challenges as a way of experimenting with 

different drawing and rendering methods. So 

this time around I decided to go on with straight 

colour – something I’m always very intimidated 

by. I tend to use lots of layers, trying to avoid 

mistakes and repainting.

Step 1
So I started off with a basic sketch where I 

already had an idea of what I wanted my jester 

to look like – a sort of semi-colourful palette 

but still a bit drab with an almost depressing 

atmosphere. So in the starting sketch I defined 

the basic motion kind of a “TA-DA!” pose, as 

if he’d just finished a magic trick (with doves, 

apparently). For the costume I wanted a big, 

puffy dress/pant thing set high up on the hips, 

making him look very leggy, with big sleeves to 

counteract the long, thin legs and wide ruffles – 

just exaggerating the costume (Fig.01). 

Step 2
Next I added basic flat colours under the line art, 

and I knew then that I wanted a chequer pattern 

in there somewhere (Fig.02). There are a lot of 

important things to remember when rendering, 

but the most important ones I think happen 

when starting to define shadows and shapes. 

Shapes are extremely important, in my opinion, 

and having them read instantly makes the image 

more captivating. 

Step 3
In Fig.03 I defined the light source, which in 

turn would help shape everything else in terms 

of depth and composition. I had this idea of 

the jester in the centre of the spotlight and 

the shadows of people in the foreground and 

background with everyone clapping. I wanted 

to leave that for last and work on the jester first, 

but time was a big issue so I left the people out 

in the end. 

Step 4
Anyway, moving on I kept refining the 

roundness in the sleeves and the shape of the 

legs using the colour palette I’d chosen, while 

mixing subtle colours from the nearby parts of 

the costume and always keeping in mind where 

the light was coming from (Fig.04). 

http://www.2dartistmag.com
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Step 5
From this point it was basically just rendering 

and figuring out the type of texture I wanted on 

the puffy dress (almost a furry, silky material), 

ruffles (very stiff, almost paper-like material), 

and the sleeves (sort of a heavy velvet cloth), 

while at the same time phasing out the line art 

(Fig.05). After flipping the canvas a few times, 

which I do now and then because when looking 

at the same image it becomes harder and 

harder to see what I might be doing wrong, I 

changed the placement of the hands and their 

shape. The sleeves were looking a bit too flat so 

I rounded them a bit more and refined the head 

shape a little further. 

Step 6
After a while I played with a chequered pattern 

which I made using the Liquify filter to shape 

it a bit more to the contours of the legs. I 

also changed the doves, giving them a more 

origami paper bird feel – I thought the sharp 

edges were a nice touch of contrast. Finally, I 

started working on the head and after a few hat 

sketches I liked the little bowler hat against the 

pale white, almost ghostly face. On the floor I 

also defined the tiles very quickly, not giving it 

too much time or attention (Fig.06).

Step 7 

Once I was satisfied with how it looked overall 

I wanted to play around with some more 

colours and the overall atmosphere, sharpening 

http://www.2dartistmag.com


certain points on the character and adding a 

bit of luminance with darker shadows. I played 

around with layers (Overlay, Color Burn, and 

Color Dodge), changed the colour of the ruffles, 

brightened certain parts of the dress and legs, 

and added colours on the face to get rid of some 

of the flatness (Fig.07a – 07b). 

Final
To wrap things up it was just a matter of final 

touches to the shadow, making it slightly darker, 

and my jester was complete (Fig.08). 

Arvid Torres
For more work by this artist please contact them 

at:

jagon_eye@hotmail.com

mailto:jagon_eye@hotmail.com
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1st Rosatron
Software Used: Photoshop

When I’m trying to come up with ideas I find it 

helps to think about what I’d like to get out of 

the final product. For this challenge I wanted an 

interesting pose, something sort of funny and 

cartoony for the jester topic. I initially pictured 

him with an idiotic face, but then when I thought 

about it, pulling a stupid face isn’t funny unless 

it’s in context. And then when I thought over 

a few situations I found funny, it wasn’t about 

the character trying to be funny, but more that 

he was trying to be taken seriously in a funny 

situation. These thoughts eventually swirled into 

my final idea, of a jester being involved in an act 

that goes wrong.

Step 1
I created a high-res canvas in Photoshop and 

zoomed out until it was a small square on my 

screen. I always like to start off with a thumbnail 

sketch to sweep in the line of action and basic 

shapes. When it starts to get too messy I lower 

the layer’s opacity and start on a new one to 

refine it. I find it handy to build up sketches on 

layers so I don’t lose the basic thrust when I 

continue to add details (Fig.01).

Step 2
I blew the canvas up so it filled the screen 

and started refining the sketch. I’m still not set 

in a particular style and I’m constantly being 

influenced by other artists. I’ve been reading 

a lot of Enrique Fernandez’s comics lately 

(http://enriquefernandez0.blogspot.com), and 

my lion’s stylisation was greatly inspired by his 

designs. His rendering is also very solid. Though 

cartoony, the form is defined without line art. To 

capture this form in my sketch I minimised my 

Hard Round brush to 1 pixel in size and started 

hatching in the shapes. This was especially 

helpful with the lion’s mane, for I realised I liked 

the silhouette but had no idea how to break it up 

(Fig.02).

Step 3
With my line finalised I went in and laid down my 

flat colour. With only my clean line art visible, 

I made sure Use All Layers was set on the 

Magic Wand and then selected a piece I wanted 

coloured. I grew my selection by a few pixels so 

that when I filled it with a colour the jagged edge 

was hidden under the line art. I lay each hastily-

chosen colour on a separate layer below my line 

art so I could Hue/Saturate adjust it later. I then 

experimented with a few colour palettes with my 

black outlines hidden so they didn’t influence my 

colour choices. After getting something I liked, 

I locked the line work’s transparent pixels and 

filled them to match their inner colours (Fig.03), 

using a method left over from the 2D animation 

colouring course I learnt Photoshop on. 

http://www.2dartistmag.com
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Step 4
After flicking between the original sketch and 

flat colour style I realised that I’d worked on 

autopilot for half an hour and it wasn’t the 

technique I wanted to use to render. So I hid my 

colour and started planning it out in greyscale. 

I used the default Hard Round brush to get my 

major tones in, using my sketchy hatching as a 

guide (Fig.04). 

Step 5
I then used the Smudge tool to blend it together. 

A co-worker recommended a special brush for 

smudging, with a spatter Brush Tip Shape and 

the Scattering turned on low. She told me that 

the Smudge tool with a hard brush is not worth 

using as it just looks like an obvious and ugly 

smear. The interesting tip shape and scattering 

helped spread the colour in a softer but more 

textured way. 

After this rough blend it was looking very 

gummy. I used a small, soft brush to start 

defining details and varying the size and opacity 

as I went along. To get the texture in the hair I 

used a spotty brush tip shape with the spacing 

down to 1%, giving the final brushstroke a 

streaky look. I duplicated my line work so I could 

still paint and blend on it, but still have another 

copy that I could flick on and off as a guide 

(Fig.05). 

Step 6
After getting it to a decently rendered stage, I flicked on my original colour 

folder, set my blending mode to Color, and was horrified at the result 

(Fig.06). 

Step 7
The colours looked awful, even when I mucked around with the hues. 

It was then that I realised the colours I had initially chosen had different 

values to the rendered tone I had ended up with. If I wanted to keep my 

http://www.2dartistmag.com


page 61 Issue 043 July 2009www.2dartistmag.com

Robots Stylised Challenge

basic colours, I should’ve used a desaturated 

version of them as my base for rendering. To 

fix this I set a merged copy of my desaturated 

colour on the Soft Light blending mode, and got 

my new greyscale image (Fig.07).

Step 8
I then threw my colour (set to Color) over the 

top and saw that finally, my original colours 

were shining through. However, I was far from 

happy. The colours were still really boring and 

ugly, looking as if the tone had been achieved 

through Dodge and Burn. The shadows were 

the same hue as the flat, just with a bit more 

black in them (Fig.08). 

Step 9
To fix this I merged the colour and greyscale 

together and used my original colour layers as a 

selection mask to Color Balance each piece as I 

saw fit. I did the lion’s fur first, really disliking the 

green brown shadows and changing them more 

to magenta. I continued to go through each 

piece, finally starting to see the picture I saw in 

my head starting to emerge. I added whiskers, a 

pattern to the belt, and a bit of pink set to Color 

on the jester’s face. I did even more tweaking 

with the Levels to get a prettier result (Fig.09).

Final
A few days later I came back to it and thought it 

could use a bit more drama. So I changed the 

background to black and added a blue spotlight 

set to Screen and a darker shadow over the 

unlit areas. I added a simple floor and some rim 

lighting to make it more interesting. After getting 

some feedback I pulled back the lighting a little 

(Fig.10), and in retrospect I probably should 

have been a bit more sparing instead of crazily 

putting it everywhere!

Looking back through my method I can see a 

lot of needless steps I went through. However, 

I learnt a lot as I went around in circles (from 

flat colour to rendered greyscale, to re-toned 

rendered greyscale based on my colour values, 

to rendered colour needing serious colour 

balance). This is the first time I’ve rendered in 

greyscale and I’ve got to admit I found it much 

easier to focus on the form this way. It took me 

a lot longer to get my colours right, but I think if I 

worked off a desaturated version of my planned 

flats to start with, I’d have reached the sort of 

colours I wanted quicker and with a lot more 

ease.

Rosa Hughes
For more work by this artist please visit:

http://www.rosatron.com/

Or contact them at:

rosatron@gmail.com

http://www.2dartistmag.com
http://www.rosatron.com/
mailto:rosatron@gmail.com


The creative process is often an adventure, every challenge is different. Incorporating new ideas and changes of direction is part of 
that challenge; we need to be flexible and responsive - and so do the tools we use. 

When turning design sketches into 3D models we always start with Power NURBS – being able to create fully adjustable parametric
models allows us the freedom to experiment and mould the design as we go, safe in the knowledge that it will render with faultless
curves and allow us to backtrack and make changes at any time.

At Chapter Two our desire is to create beautiful images - nPower helps us achieve that goal.

Chapter Two Productions specialises in high resolution visuals for Advertising, Marketing and Product Design.

 http://chaptertwo.co.uk/Find out more about chapter.two at 

Power NURBS delivers. Power NURBS delivers. Power NURBS delivers. 

To find out how nPowerSoftware can help your CG workflow visit us at www.npowersoftware.com

http://npowersoftware.com/


Exchange insight and inspiration with the animators, artists, researchers, developers, and producers 
who are creating this year’s most amazing experiences. In the city that has been inspiring musical 
innovation, culinary excellence, visual splendor, and architectural wonder for 300 years. You’ll return 
from SIGGRAPH 2009 with re-energized imagination, renewed skills, and insider information to 
spark your creativity and surpass your goals for the coming year.
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Join some of the world’s fi nest players at SIGGRAPH 2009 in New Orleans.

http://www.siggraph.org/s2009/


This tutorial series will revolve around the use of 3d as a starting point for digital painting. In particular we 

will explore the value of Google SketchUp, a free program enabling users to quickly build 3d environments 

using a set of intuitive tools.

This technique is used by many contemporary artists and is used as a quick and effective way of 

establishing correct perspective as well as offering a moveable camera in order to experiment with 

compositions.

As a 3d package SketchUp is easy to learn and does not require hours of training and as an artist wishing 

to draw complicated scenes, this approach can prove a valuable starting point for producing a template on 

which to paint over.
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Why use SketchUp?
Google SketchUp is a free programme enabling 

users to quickly and effectively build 3D environ-

ments using a number of intuitive tools. Unlike 

most 3D packages it is very easy to learn and 

does not require hours of training before decent 

results are achievable. It is very versatile and 

with regards to digital painting can prove an 

invaluable tool in swiftly establishing a correct 

perspective, as well as offering a moveable 

camera in order to experiment with alternative 

viewpoints and compositions. 

An object can be made and then duplicated 

any number of times, so if a structural element 

is repeated throughout your concept then this 

package can quickly and accurately create 

such arrays. It also has a simple-to-use lighting 

system that enables placement of the sun ac-

cording to the month and time of day by way of 

slider bars, thus determining physically correct 

shadows that can be turned on or off at the click 

of a button. These functions mean that as an 

artist wishing to draw detailed or tricky scenes, 

one can use SketchUp as a valuable starting 

point to establish a “guide template” on which to 

paint over.

Installation
In order to install SketchUp, click on the link be-

low and go to Downloads on the left hand menu. 

Select the free version which is currently version 

7 (Fig.01). Choose your operating system and 

then follow the instructions. 

http://sketchup.google.com/

Once installed, click on the application shortcut 

and you will be prompted with the following 

dialogue box in which you are asked to choose 

a template (Fig.02). The scale and type of your 

scene will determine which you choose, but for 

the purposes of this tutorial we will select Archi-

tectural Design – Feet and Inches.

Toolbars & Menus
When SketchUp starts you will see a screen 

resembling Fig.03. From the main menu click 

on View > Toolbars > Large Tool Set; this will 

access more tools which will appear down the 

left margin. To change the display mode of the 

objects in the scene click on View > Face Style; 

this will show a number of options, as seen in 

Fig.04.

If you also check Views under View > Toolbars 

you will see six small house icons appear below 

your toolbar (Fig.05). These will provide quick 

access to orthographic views, as well as iso-

metric. You will notice that I have also checked 

Face Style in the list (highlighted in green), 

which has added some cube icons to represent 

the display modes. 

This is basically where you can customise your 

workspace and add toolsets to speed up your 

workflow. For additional help go to Window > 

Instructor; this will open a window providing 

useful information on whichever tool you have 

currently selected.

http://www.2dartistmag.com
http://sketchup.google.com/
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One other useful function, especially for archi-

tectural structures, is the Offset tool which is 

situated next to the Rotate tool. This enables a 

shape to be duplicated in order to create depth 

– perfect for drawing walls in a building, for 

example (Fig.11).

Basic Navigation
The key orientation tools you will use to navigate 

in your scene are Orbit, Pan and Zoom, which 

you will find on the top toolbar and whose short-

cut keys are represented by O (Orbit), H (Pan) 

and Z (zoom). These can be seen in Fig.06.

The main tools used to directly manipulate your 

objects are Move (M), Rotate (Q) and Scale (S). 

The Scale tool appears on the left hand toolbar 

which you will see highlighted if you press S on 

your keyboard.

Drawing Shapes
One way of using SketchUp is to create two-

dimensional shapes from which you can extrude 

three-dimensional objects. Select the top view 

and then the Line tool (Fig.07) and left-click in 

the viewport to begin drawing. You will notice 

that as you do so, the points will snap to the 

green and red axes, thus easily enabling the 

creation of right-angled structures.

When you finally close the shape by clicking on 

the initial point you will notice the shape turns 

blue, indicating a surface has been made; once 

a shape has become closed you can still edit 

it, however. Using the Line tool, add an internal 

rectangle (see top diagram in Fig.08). To now 

make this edge become part of the exterior 

shape click on the Eraser tool and then on the 

outside edge shown in red.

You can continue to cut into your shape or alter-

natively extend it outwards and then erase the 

necessary lines by using the Line tool (Fig.09). 

Here I have added a walkway and also a curved 

section using the Arc tool. You can also draw 

more organic shapes using the Freehand tool 

(Fig.10).

With an exterior wall depth, click on the large 

internal shape using the Select tool (black arrow 

on Toolbar) and hit delete. You can then select 

the Push/Pull tool and then click on the wall and 

raise it vertically (Fig.12). You will notice I have 

edited the section where the walkway adjoins 

http://www.2dartistmag.com
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the building using the Line and Eraser tools so 

that this was not raised along with the outer wall.

Three Dimensions
When a shape has been converted into 3D it 

can be edited further by using a combination 

of the Line and Push/Pull tools. If you move 

the Line tool along an edge it will snap to the 

midpoint between opposing edges (Fig.13). You 

can then make equally spaced cuts, as shown. 

These new shapes can be pushed inward or 

pulled outward, or alternatively a new shape can 

be drawn and this can then be manipulated.

In Fig.14 I have used the Offset tool to create a 

window shape in the far left rectangle. To create 

the same proportioned window in the other sec-

tions simply select the Offset tool and double-

click in each rectangle. To create the arches use 

the Arc tool and then erase the horizontal join 

shown by the dotted line. To create windows 

use the Push/Pull tool to move the shapes 

inwards beyond the inner wall surface or until 

they disappear. 

Using a combination of the tools mentioned 

so far you will have the means through which 

to create and edit a wide range of forms and 

design detailed scenes.

Atmospherics & Lighting
You can add atmospheric perspective in the 

form of fog to your scene. Go to View and check 

Fog, as seen in Fig.15. You will notice that the 

edges on my building have also been switched 

off, which you can control in the menu under 

Edge Style > Display Edges.

To add lighting effects check Shadows which 

is above the Fog label, and to get more control 

over this function go to View > Toolbars > 

Shadows. This will place two slider bars on your 

toolbar which denote the month and time of day. 

By adjusting these you can control the position 

of the sun and direction of the shadows (Fig.16). 

There is a little icon to switch the lighting on or 

off, and besides this there is also another icon 

which opens up some extra parameters that al-

ter the tonal range of the shading. You can also 

control whether this affects just the object itself 

or the ground along with it and vice versa.

Additional Tools
A few other useful tools worth mentioning are 

the Tape Measure, Protractor and Dimension. 

The Tape Measure is used to draw guidelines 

which can then be traced over with the Line tool. 

In Fig.17 you can see that the tape measure 

has created the dotted lines which can be used 

as a guide to draw the windows an equal dis-
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tance from the top and bottom of the block. To 

delete the lines simply use the Eraser tool.

The Protractor is used to create accurate 

angles. Move the tool to the point at which you 

wish to start the angle and you will see how it 

snaps to the three axes. Click to establish the 

correct plane and then click to begin the angle 

along the appropriate edge. Now you can set 

the angle using the guideline. In Fig.18 I have 

used the near corner as the starting point, which 

I will mirror on the opposite corner.

Once the guidelines are drawn, trace them 

using the Line tool, as with the Tape Measure. 

In Fig.19 you can see that the two angles have 

been drawn and then the Push/Pull tool was 

used to extrude a roof shape across the base 

block.

The Dimension tool simply adds a label to 

your scene, showing the distance between two 

points. Click and drag from A to B and then drag 

up or down to set your dimensions, once again 

using the Eraser tool to delete when necessary 

(Fig.20).

Cameras
The camera in SketchUp is initially placed at an 

average eye level height, so for example when 

you click on the Position Camera tool it will 

zoom in and appear around head height from 

the ground. In this sense scale is an important 

factor in your scene. 

In Fig.21 you can see a cross where I intend to 

position the camera, after which the viewpoint 

will resemble the inset image. The character has 

been placed in the scene to demonstrate the 

relationship between the scale of a character 

and the initial camera height. To adjust your 

camera, use the Look Around tool represented 

by the eye icon.

One final tool which may prove useful is the 

Section Plane tool which allows a view of a 

cross-section of your object. To use this click 

on the tool and then align the green icon to the 

corresponding plane or angle you wish to view. 

Then select the Move tool and click on one of 

the corner arrows and drag in the relevant direc-

tion (Fig.22).

This concludes our overview which I hope has 

at least introduced the main tools and their 

functions. There are of course further lessons 

to learn along with other tools and techniques, 

such as applying materials, but the main aim 

here is to introduce the interface and value of 

the software in terms of building a simple 3D 

environment which can then be used in digital 

painting.
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Created In:

Google SketchUp and Photoshop

Introduction
The painting that forms the core of this tutorial 

will begin its life as a 3D environment within 

the free version of Google SketchUp. This 

programme is a very intuitive and simple 3D 

modelling package that uses a limited number of 

practical tools.

The 3D scene will then be used as a template 

within Photoshop to create the final painting. As 

such the scene will already integrate accurate 

perspective and also enable the addition of 

lighting effects which can prove useful when 

using complex forms.

The final image will culminate in a digital 

painting, but will retain the above aspects as 

part of its structure and hence show how simple 

3D can be incorporated into a 2D process.

Concept
The first stage involves conceiving an 

idea behind the image and establishing a 

composition. Because we are using a 3D 

scene, we have the advantage of a camera 

which means that a final composition does not 

necessarily need to be decided early on. Once 

the scene is built the camera can be moved 

in order to experiment with the most suitable 

vantage point.

For this concept I want to create a scene on a 

large scale, utilising atmospheric perspective 

with repeatable shapes and thus help 

emphasize the value of using 3D. I pictured 

a vast chamber or hangar of some kind in 

which large scale structures would sit and form 

congregational areas. I imagined them as either 

assembly points or maybe even areas to set up 

market stalls akin to a futuristic bazaar.

Google SketchUp
With a vague notion in mind I begin drawing 

shapes and pulling out forms in SketchUp. 

Because the software enables a quick and 

effective way of modelling it is perfect for 

experimenting with simple forms. I build the 

main chamber using boxes and then use the 

Circle tool to create a cylinder. Using the Select 

tool I then highlight certain edges, and then by 

holding down Ctrl with the Move tool I add new 

lines/subdivisions. I then scale these to form the 

umbrella shape seen in Fig.01.

I decide to include some elevated walkways 

which will span the chamber at intervals. These 

are initially made using the Rectangle tool and 
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then I use the Line tool snapped to midpoints 

to divide the shape evenly (red arrow Fig.02). 

The windows are created by way of the Offset 

tool (blue arrow) and to ensure each are exactly 

the same proportion I simply double-click in the 

next section after creating the initial offset. I 

then use the Push/Pull tool to inset them using 

the same method of double-clicking to maintain 

consistency.

 

To create an “umbrella” which I can manipulate 

means re-building it using the Polygon tool, as 

SketchUp does not allow the pushing/pulling of 

smoothed or curved surfaces. I need a shape 

with 24 segments and to do this I type the 

number of sides followed by the letter S after 

dragging out the initial shape (Fig.03).

To add some interesting shadows and also 

accentuate the perspective I suspend a grid 

above the scene to resemble the framework of 

a yet unfinished structure (Fig.04). To create 

an evenly spaced network I make the first box 

and duplicate it (hold down Ctrl + Move/Copy tool); once copied I type in a 

distance. You can repeat this process to add further pieces.

Using a combination of the Line and Push/Pull tools I add some detail and 

balconies to the main wall (Fig.05).

Fig.06 shows the final scene with the inclusion of shading. The umbrella 

frame was made using the Offset tool, as done with the walkways, and 

then deleting the inner polygons before pulling out the framework. The 

dialogue box for the lighting (inset) shows the four slider bars which 
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correspond to the month, time of day, as well as 

the tonal range of the lighting.

Painting
Once your scene is complete and you have the 

camera in the desired position, screen-grab your 

image and then open it in Photoshop. Here you 

will need to re-size it according to your needs 

before beginning any of the painting. 

I alter the lighting settings in order to save out 

the shadows as a separate render (Fig.07). By 

applying a black colour to the geometry and 

hiding certain elements it is also possible to 

save out masks, as seen in the right column.

With the numerous renders saved, I begin by 

adding in some brushwork and colour overlay to 

try and establish the overall lighting and mood 

(Fig.08). You can see here that the main scene 

is overlaid across the image to act as a guide. 
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I organise the file in a way that enables me to 

easily edit it and make changes later on using 

certain layers set at specific blending modes 

(Fig.09). This way I can distinguish the colour 

from the lighting and allow it to be altered 

independently with ease.

Fig.10 shows the image with the shadow and 

sunlight layers visible. I also add some sunlight 

streaming in above the framework which uses a 

Layer Style (Fig.11).

I decide to add some lights along the underside 

of the umbrella which are placed on a new layer 

at the top of my file. I then add an Outer Glow, 

as with the sky light, and then duplicate the 

layer, first removing the copied glow and instead 

apply some Gaussian Blur to enhance the glow 

even more (Fig.12 – 13). 
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To reflect this I paint in a pool of light on the 

ground below, which I blur and set to Overlay. 

To create some variation across the floor and 

wall I create a small image of randomly sized 

rectangles in slightly different colours. To align 

these with the perspective I use the Vanishing 

Point Filter (Fig.14). Once pasted in they can be 

moved, scaled and duplicated as needs be.

In Fig.15 you can see the subtle patchwork that 

extends along the wall which helps break up 

the surface somewhat. I have also placed some 

illuminated windows in the scene using the 

same technique.

The same panels can be used on the main stem 

of the umbrella; however, they will need to be 

skewed to fit with the perspective. This can be 

done by going to Edit > Transform > Warp. In 

Fig.16 you can see the grid that appears along with the Bezier handles 

used to manipulate the image.

The glow at the foot of the umbrella certainly helped, but the lights 

themselves do not seem intense enough to throw out such a pool, so in 

order to fix the problem I add a new layer and paint in a soft green area 

surrounding the bulbs (Fig.17 – 18). Once blurred and set to Screen 

blending mode it makes a big difference, and to further the cause I also 

add a gradient layer below this, set to Multiply at 60% Opacity. This 

blended from a cool foreground green to a warm off-white in the distance. 

Not only does this intensify the umbrella lights but it also serves to 

separate the foreground and distance.
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The foreground looks sufficiently detailed at the 

moment but the background umbrellas still lack 

a little definition. On a further layer I add in some 

subtle variations and a few lights (Fig.19).

Adding Characters & 
Textural Detail
The repetition of the umbrella helps convey 

a sense of perspective, but to really give the 

scene a scale we can use a common device – 

the inclusion of figures. In Fig.20 I have added 

a crowd of characters spanning the foreground 

through to the distance which serve as a 

measuring stick.

To help define the foreground a little more we 

can use photographs to add detail and suggest 

an architectural style. It is a question of sifting 

through reference images to find the most 

suitable types of imagery. Once pasted into your 

picture it will need to be correctly aligned either 

by hand or by way of the vanishing point filter, 

and normally it is necessary to colour correct 

it. In Fig.21 you can see where the two photos 

have been positioned and adjusted to fit in with 

the scene. Either desaturate the photos and 

then select Overlay or Soft Light as the blending 

mode, or use a combination of Curves and 

Image Adjustments to blend them in and leave 

on Normal mode, as I have done in this case. 

It is a good rule of thumb to reserve this type of 

detail to the most prominent areas only – the 

near section of wall in this instance.

We can apply this principal to the characters 

and add detail to the nearest few – albeit 

with brushwork, but nevertheless continuing 

this treatment of having more detail in the 

foreground (Fig.22). I also decide on some 

railings along the near side which echo the 

elevated framework and help balance the top of 

the image with the base.

Final Refinements
The painting is at a stage where it can almost 

be called complete, aside from a few minor 

tweaks which will further enhance it. One area 
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that will benefit from some extra treatment 

is the background section where the ground 

plane meets the horizon line. As the chamber 

is brightly lit at one end it follows that the light 

will bleach out the most distant figures and also 

be reflected someway along the floor. Fig.23 

shows the before and after stage which uses a 

soft, blurred pale green layer set to Hard Light to 

create this extra depth, and which also helps the 

far umbrella recede a little more.

If we look back at Fig07 you will notice the flaws 

apparent in the shadows layer which does not 

take into account atmospheric perspective. It is 

possible to switch on Fog in SketchUp but this is 

best achieved in Photoshop for more accurate 

results and emphasizes why the 3d renders 

should only be considered a guide.

I also add a new skylight using an orange Outer 

Glow as part of the Layer Style, as I feel that the 

blue colour jarred too much with the scene as 

a whole and neither created a warm or intense 

enough light that seemed to reflect the overall 

mood (Fig.24).

It is good practice to work on multiple layers 

during the painting process in order that 

changes can be made easily at any point and 

certain details such as the crowd can be hidden 
or even duplicated if needs be. When you feel 

confident that you do not need to make any 

more changes you can flatten all or at least a 

selection of your layers.

The last stage that I often employ is an 

Adjustment Layer of some sort, as this enables 

further alterations to the painting such as colour 

scheme, contrast and lighting. The great part of 

this function is that it offers the use of a mask to 

localise the effects and also means that it can 

be reversed or even discarded if needs be. 

In Fig.25 you will notice a Colour Balance 

Adjustment Layer at the top of the Layers 

palette in which I have moved the sliders 

towards a warmer colour (red and yellow).
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 The small white areas evident in the mask 

reveal these warmer values which are seen 

beneath the umbrella, whereas the black acts as 

a mask hiding this colour adjustment. 

And this last modification marks the end of the 

painting, the final version of which can be seen 

in Fig.26.

Conclusion
It has been regarded by many traditional artists 

(including myself to a degree) that using 3D as 

a template for a 2D painting promotes a less 

skilful approach. It is undeniably true that by 

drawing this particular scene as opposed to 

using 3D would have required a greater regard 

and understanding of perspective, and that 

creating an accurate replica would be far more 

challenging. However, it also follows that by 

creating a digital version of a concept is also far 

more forgiving a process than using actual paint 

and brushes.

If we view digital painting as an accepted 

practice within certain sectors of the modern, 

commercial art industry, which I believe is 

inarguable then surely 3D is but another yarn in 

this weave we know as “digital art”. After all, can 

we not regard 3D as the carefully lit life models 

set up by the Old Masters, or a substitute for the 

camera used by so many painters over the last 

century?

Programmes such as Google SketchUp 

allow artists to quickly and easily explore and 

experiment with ideas that relate to form and 

composition, and in so doing inform their work 

and lend it a believability. More importantly 

it can save time in the long run, which is an 

important factor in today’s climate.

I hope that this tutorial has validated in some 

way the inclusion of 3D in a 2D world, but it 

is worth remembering that there is no real 

substitute for traditional art skills – all software, 

no matter how sophisticated, is useless without 

a puppeteer!

Richard Tilbury
For more from this artist visit:

http://www.richardtilburyart.com/

Or contact them at:

 rich@3dtotal.com

http://www.richardtilburyart.com/
mailto:rich@3dtotal.com
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Welcome to the Speed Painting section of the magazine. This 

month we’ve asked two artists to produce a speed painting 

based on a simple, one-line brief. Here we feature the final 

paintings and the overview of the creation processes. 

This month our talented artists, Robin Olausson and Richard 

Tilbury, tackle the topic: 
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Robin Olausson
Created In: Photoshop

Introduction
Ok, so for this theme I would like to do 

something different; my first thoughts were to 

make some kind of a landscape with cliffs and 

aggressive waves hitting the coastline, but 

then I came up with something along the same 

lines but different … I’m going to take the idea 

of aggression and try to convey it in a smaller 

scene, rather than a huge ocean. I want to make 

a narrow and ‘up close’ situation. So let’s get 

started.

Step 1
With a large Soft Round brush I start blocking in 

shapes, just to get a feel of where I’m heading 

with this piece. The next things I want to achieve 

at this early stage are to get some kind of depth 

going on in the image, as well as getting a feel 

for the general lighting – the direction of, etc. 

The round, hard-edged shapes make me think 

that they could perhaps be some form of rock – 

you know, rocks that have been worn down by 

years and years of wind and water, eventually 

making them smooth (Fig.01).

Step 2
Since I’m heading for a picture with depth in it, 

there needs to be some kind of a perspective 

going on. Even if you’re dealing with mostly 

abstract, natural-shaped objects, you still need 

to deal with perspective. With different sized 

rocks and water waves, I’m introducing some 

abstract perspective whilst at the same time 

framing the image, thinking of the composition 

and trying to lead the viewer’s eye around the

piece, preventing their attention from falling off 

the image by ‘blocking’ the corners and leading 

them back into the scene (Fig.02).
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with some minor focal points as well, and a 

descending composition. However, it seems 

too heavy at the bottom and feels like there is 

something missing in the upper part. So with a 

regular round brush I scribble in a house with 

some new colour, slowly building up visual 

interest throughout the entire piece (Fig.04). 

Even though this is a speed painting you should 

think about what you are doing. I mean, I’ve 

Step 3
Before this stage the image was very 

monochromatic and dull, so here I’m bringing in 

a couple of new colours – just subtle changes 

in hue, nothing too saturated. I’m thinking of my 

whole painting process like sculpting in a way, 

trying to carve out the elements. The same thing 

goes for the colouring; I start slow with minor 

differences in hue just to get some variety to the 

piece, and as the whole image progresses there 

is room for more colour – just don’t push it too 

hard in the beginning and try to save up your 

contrasts for later. 

As you can see, I’ve kept the perspective in 

mind while painting the water; as things descend 

into space they get smaller, and so does my 

stream of water (Fig.03).

Step 4
Ok, so we now have a good start to the image: 

we’ve got some depth going on, a focal point 

seen lots of young artists who are fairly new 

to digital painting fall into the pitfall of thinking 

that speed paintings just focus on painting as 

quickly as possible, without paying real attention 

to what they are doing. Take your time; speed 

comes with practice, it’s not something you gain 

instantly! Sure, there are reasons to do speed 

paintings really quickly as well: it forces you 

not to think too much about what you are doing 

and is really good for your creativity; it makes 

you come up with things you never would have 

otherwise … But! You’ve got to know and be 

able to see the difference. There are lots of 

great artists that can paint awesome speed 

paintings in 1 to 2 hours, but this doesn’t mean 

that they do it sloppily! From practice they know 

what to focus on to make the image work. My 

advice is to take it slow; aim to make a good 

picture out of it and don’t think too much about 

how much time it takes, as it’s the end result 

that matters.

Step 5
There really isn’t too much to say about this 

step, it’s all about giving the viewer’s eye some 

more detail to feast on. For the yellow sky I 

make a new layer set to Overlay and use a 

large Soft Round brush to paint. I try to keep 

my layers as few as possible only working with 

around 2 to 3 layers at one time; I then merge 

them down when I’m happy with the result. The 

tree in the background is made using an opaque 

brush with no pressure sensitivity on to get 

some crisp and sharp edges. The foreground 
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foliage is made with a custom brush – a pretty 

standard foliage one – plus some selection tool 

work (Fig.05).

Step 6
Finally, I merge the whole image and transform 

it (Edit > Transform > Distort), which is actually 

s a pretty good way of trying new stuff out. I also 

change the overall colours slightly by copying 

the whole image and then changing the Curves 

(Ctrl + L) and the Hue/Saturation (Ctrl + U). 

Following on from the previous step I also add 

even more detail, such as more rocks, splashing 

waves and adding the figure into the foreground. 

This is all pretty easy since I have my colour 

palette worked out as well all the values across 

the image, so it’s just a matter of colour picking 

and refining details (Fig.06 – Final).

Conclusion
When you’re doing a speed painting, if you have 

an idea in mind, try making some thumbnails 

before you start rendering things out, and for 

speeding things up try out some brushes with 

customised attributes, such as Dual Brush, 

Scattering, etc. If you don’t have a clue about 

what you’re going to paint, I suggest keeping 

it loose and fast in the early stages, but don’t 

lose what makes a good image in the end; try to 

keep this in mind when you start rendering your 

paintings.

Robin Olausson
For more from this artist visit

http://www.robinolausson.com/ 

or contact

tv1000@spray.se
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Richard Tilbury
Created In: Photoshop

Introduction
A couple of months ago I spent a week in 

Cornwall in southern England, and during my 

time there made some excursions to a few 

coastal fishing villages. The experience of 

watching the waves crashing into the rocks 

and harbour walls will help to fuel this particular 

speed painting. The Atlantic Ocean has a wilder 

and more ferocious nature compared to the 

English Channel, and so this coupled with the 

rugged coastline gives me plenty of memories to 

draw upon here.

I begin by creating a canvas with a wide 

landscape aspect in order to try and emphasise 

the vastness of the ocean. I lay down a blue 

grey colour for both the sky and sea, and 

place the landmass at the right edge of the 

composition (Fig.01).

To add some depth to the scene I paint in a 

distant headland, jutting out to sea, which also 

helps to lead the eye across the canvas space 

from the right hand side (Fig.02).

At this stage the image looks very bleached and 

washed out, and is in need of some more colour 

and drama. I add a touch of cerulean blue to 

the water and darken the sky to suggest an 

oncoming storm (Fig.03). 

As the title is hinged around waves, I decide to 

create a custom brush for this task alone, which 

I use to block in the foreground foam (Fig.04).
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I then reduce the overall brightness of the 

picture (Image > Adjustments > Brightness/

Contrast) and add some darker shadows along 

the rocks to create more contrast (Fig.05).

The next step is to add more foam to convey a 

rough sea and help illustrate the ferocity of the 

waves hitting the rocks. I use a custom brush 

which incorporates some Scattering and Dual 

Brush functionality to give me a spray like effect 

(Fig.06).

I decide that the shape of the headland needs 

to taper off as the shape seems somewhat 

awkward. I also paint in some more foam 

around the landmass to help its relationship with 

the water, as well as softening the edges of the 

spray a bit more using the same brush as before 

(Fig.07).

The painting is all but finished now, barring 

a few small changes. I create a new layer on 

which I paint in a blue colour at around 65% 

opacity to make the distant cliffs look even 

further away. 

Throughout this process I have been painting on 

a number of layers in order to give me the ability 

to backtrack for the purposes of this tutorial. 

It is always good practice to flatten these at 

intermediate stages otherwise the files can 

become very complicated and take up a lot of 

memory.

Once satisfied, I flatten the image and then 

finish by applying an Adjustment Layer that 

affects the brightness and contrast. I darken 

the entire image and then, using a Soft Round 

Airbrush set to black, paint into the mask to 

reveal the original image apart from the sky. 

This I leave a darker grey to keep a stormy feel 

throughout the picture (Fig.08).

Richard Tilbury
For more from this artist visit

http://www.richardtilburyart.com/

or contact

rich@3dtotal.com
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http://www.richardtilburyart.com/
mailto:rich@3dtotal.com
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This series of tutorials aims to show some of the methods and processes used to design and develop characters 

from initial thumbnail sketches through to a final concept. The series will be divided into five parts and will focus on 

the general design methods commonly used by character artists. It will begin with quick sketching techniques used to 

suggest ideas and develop a theme before moving onto creating variations once a subject is established. The third 

instalment will culminate in a finished concept design, after which we will move onto the importance of posing your 

character and the impact this has on their personality. The series will conclude with a chapter dedicated to choosing 

suitable eye levels and camera views to best convey an emotional state or emphasise a storyline.

Chapter 1 – Thumbs & Silhouettes

The opening chapter looks at the techniques behind thumbnail sketching and producing a series of small silhouettes 

to describe character traits. This method of working is an effective way to suggest and explore ideas and 

shows how factors such as shape and proportion can contribute greatly towards a characters personality. 

Chapter 2 – Visual Brainstorming – Variations on a Theme

Chapter 3 – Speed Painting & Concept Design

Chapter 4 – Dynamic & Exaggerated Poses 

Chapter 5 – Camera Placement, Framing, Fore-shortening & Distortion

“Whichever resources you 
choose to draw upon, just 

make sure you use it as 
inspiration only and don’t 

plagiarise the work. ”
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Created In:
Photoshop

Introduction
Creating artwork is a wonderful gift, a pleasure 

that I cherish and indulge in on a daily basis, 

because it is both my favourite past time and 

because it is also my profession. For myself, 

and undoubtedly many of you reading this, there 

is no comparable experience of diving stylus first 

into an alternate reality, indulging our coolest 

ideas and dancing the tango with plain old 

creativity. However, speak to any artist and I’m 

sure they’ll vouch for the fact that it is also an 

activity that can drive many of us to the heights 

of frustration. This is especially true if we don’t 

have battle tested procedures and processes 

that we can rely on when inspiration and a loose 

brush alone aren’t enough.

This topic delves into the very heart 

of the creative process, the initial 

flowing of ideas onto paper when 

we feel our ideas are strongest and 

also gives insight into workflows 

you can rely on when your art 

director comes back to 

you and says, “Give me 

something more!”  

Now, before we begin, I’d like to 

point out that even though these 

ideas are easily incorporated into 

casual or fine art making, my focus 

(and my experience) is that of a commercial 

artist, and as such this is the audience my 

writing will speak most clearly to.

And with all that out of the way, let’s get started!

Before you get started
If you know me, then you’ll know what I am 

going to tell you to begin with – your research! 

Whether you know or understand the subject 

matter intimately or not, you need to fill your 

consciousness with new information on a 

consistent basis in order to provide fresh ideas/

reminders for your images … or you’ll risk 

growing stale and creating highly derivative art.

What does this mean in a practical sense? Well, 

in today’s age of blogs, online articles, image 

archives, forums and the like, this essentially 

means jumping on the internet and using your 

favourite search engine to source out some 

visuals to kick start your engine. Some of my 

favourites are listed below – it certainly isn’t 

exhaustive, but these are typically all I need to 

find good references:

• www.Google.com

• www.ConceptArt.org

• www.Flickr.com

If you don’t have the internet (in which case I’m 

not entirely sure how you got this e-magazine 

in the first place) then it means a little more 

leg work: going to your local library, picking 

up a newspaper, magazine, trade journal, or 

watching a movie and stockpiling your mental 

arsenal from there can also be a good start.

Whichever resources you choose to draw 

upon, just make sure you use it as inspiration 

only and don’t plagiarise the work. That would 

be unscrupulous and does not help your skill 

level grow; indeed it will more likely lower your 

confidence in your own abilities.

Thumbnail Sketching
So you’re given your brief, you experience that 

irrevocable moment in which you are delivered 

your design task and the synapses start firing off 

instantly and a myriad of images start flashing 

through your mind. 

Now what?

Well, the best thing to do is to start getting 

your ideas into visual form, whether on paper 

or digitally. Don’t talk about it with other 

people, we’re not professors 

of literature, there’s plenty of 

time for discussion later – just 

get your pen moving and don’t 

stop!

Should you warm up, I hear 

you ask? Should I practice 

something to get the blood 

flowing through my fingers, 

you might say?

Nope, don’t sweat it!

http://www.2dartistmag.com
http://www.Google.com
http://www.ConceptArt.org
http://www.Flickr.com


page 90www.2dartistmag.com Issue 043 July 2009

 Part 1: Thumbs, Silhouettes & Special Brushes Dynamic Characters

You know what? The first few will probably 

be really bad, just accept it and have the 

confidence to know that the more little sketches 

you do, the better they will be as you go along.

It is important to understand that how it looks 

right now is of little importance at this early 

stage, they are representational shorthand ideas 

for yourself that will lead to more developed 

ideas down the track. It helps to imagine 

yourself as a documentary agent, trying to 

capture the images that are flashing before your 

mind’s eye. 

Quick Initial Sketches – So to start off (Fig.01), 

I create a relatively small canvas on my screen 

in Photoshop – roughly 400 pixels by 400 pixels 

at 72 dpi. Now, this is a fairly small size and 

nowhere near print quality, but because this is 

the digital medium I am using it doesn’t really 

affect me as I am able to upscale at any time. 

Another practicality is that the canvas does not 

chew memory; at such a miniscule size your 

brushstrokes can be as free and wild and quick 

as you like, with no danger of lag. Of course, 

with today’s increasingly fast computers this 

tends to be less and less of an issue, but I 

still like to start off at a small scale so as to 

resist the temptation of jumping into the details 

immediately.

As the name would suggest, thumbnail sketches 

(or simply thumbnails) are very small scribbles, 

designed to be fast, putting down what you feel, 

emptying your mind of your current thoughts so 

that they may be replaced by more ideas, and 

by jotting these ideas in quick succession you 

are aiding the velocity of the process.
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If you are wondering what sort of sketching you 

should use to document your ideas, or how 

much is too much or too little, then you’re most 

likely not alone. The answer is that you should 

use as much information as you need, but as 

little as possible. If you feel you can sketch a 

character using just plain old line work, then 

so be it. If you need to put in some value to 

bring out the form, then do that. There is no 

single answer for everyone, and so you should 

document your ideas using what you feel 

comfortable with. 

Please, don’t be afraid to go crazy at this stage, 

every thought is fair game to be plotted on 

your sheet – in fact, some thumbs will simply 

be filler used to dirty up the page. I don’t know 

about you, but a blank sheet staring me in the 

face is intimidating, it’s saying to me, “I dare 

you to dirty me up … Oh no, actually I double 

dare ya!” To which I usually reply by throwing 

down a few incoherent lines to get past that 

initial Clean Sheet Syndrome. Once that page 

has been violated with scribbles, it is no longer 

as imposing to draw on and a mental barrier 

is broken, allowing your sketches to flow more 

freely.

Trying Out Different Types of Sketches – As 

you can see from Fig.02, I am 

not coy about creating “dirty” 

marks on the page – in fact 

I think it can go some way to 

breaking that computer illustrated 

look that so many digital art 

beginners seem to fall into.

I tend to work with 

very simple brushes, 

or brushes that come 

standard with the programme 

I use, which is Photoshop 

– mostly a combination of 

soft airbrushes and harder 

edged airbrushes with reduced 

spacing so as to mimic 

continuous tone. I tend to use 

these brushes as a high-tech version of a pencil 

or a block of chalk, typically starting by laying 

large areas of tone onto the canvas before 

cutting back into the shapes with white. 

In order to facilitate this quick process I mainly 

use my stylus, the spacebar to grab the canvas, 

and the Alt key to colour-pick the tones I want 

from previous laid down strokes. When you get 

used to it, this is a very quick method of working 

and allows you to put your ideas down very 

quickly.

You may also notice on the illustration (Fig.02) 

that there are some images that look very 

similar to each other – herein lies another of 

digital media’s advantages: the ability to create 

variations simply by using the Marquee Tool and 

creating a new layer using the existing illustrated 

layer as the source. This will then allow you 

illustrate over the image, creating a variation 

side by side to the original. The beautiful thing is 

that it frees up your inhibition to experiment and 

can be done infinitely!

Now, up to this point, we’ve been thinking of the 

sketches as a personal tool – that is, an external 

representation of a myriad of internal ideas in an 

attempt to organise free-flowing thoughts into 

a structured pattern for our own personal use. 

We have part of the design in our minds and 

this can often cause us to stop short of creating 

sketches that mean anything to anyone but 

ourselves. 

This situation would be fine if the work we are 

doing is only for ourselves, however, most 

often the art we do isn’t just for fun, 

it’s because someone is paying us 

to deliver. These people need to 

understand what we are thinking 

at every step of the 

process to 

reduce the 

likelihood of 

going in the 

wrong direction down the 

line – it saves them time (and 

money), and it saves you the 

frustration of having to do major 

rework.

So this is a very important 

consideration to keep in 
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mind (important enough that I am reiterating it) 

– as commercial artists, we never operate in a 

vacuum, our work is generally part of a greater 

whole, in editorial enhancing the writing or as 

concept art which precedes the asset building 

phase of game or film development. In short, we 

need to share our ideas effectively with other 

people, and most often with people who are not 

artists.

Cleaning Up – Looking at Fig.03 now, I have 

chosen to clean up this design because I feel 

the character has poise, balance and potential 

to experiment – it is also the least developed 

and would demonstrate the process between 

a rather abstract image built of large shapes 

and how you would begin to add in the design 

elements gradually.

In this case, I also increase the resolution to 

1221 pixels by 657 pixels, so that I will be 

comfortable while adding the details. I’d also 

like to mention that in most of the concept art 

positions I have worked in, the bulk of this kind 

of work is done as a rough guide for the 3D 

artists who tend to work with dual monitor set 

ups, so print versions are not really required. If, 

however, you need to generally print off your 

work, stick to working on at least A4 as this 

will allow you sufficient detail to print off on A4 

sheets.

Silhouettes
Like everything else in art, ideation is a fluid 

process that does not always take the same 

route. Indeed I would even go as far as to 

encourage you to occasionally venture upon 

the path less travelled in order to derive new 

processes, new styles and new ways of thinking.

Creating silhouettes are simply another form of 

visual shorthand, a tool that can be used as a 

fore-runner to a fully fledged design besides line 

and tonal sketches. 

Silhouette Design – As you can see from 

Fig.04, creating a silhouette is designing the 

character from the outside inwards; you are 

determining the features that directly influence 

the extents of the character and blanking the 

rest, leaving your imagination to fill in the details.

In the example you can again see the use 

of duplicates, allowing me to fill a page of 

silhouettes very quickly by using the copy-paste 

method. This will free up your time to work on 

making sure that each silhouette receives your 

attention, regarding their individuality and unique 

qualities.

Adhering to the principles of creating silhouettes 

is important for a number of reasons:
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• It removes the temptation of spending 

too long on the minutiae – not being able 

to putter away endlessly on infinitely small 

details expedites the process and forces you 

to think of the big picture

• It enhances the amount of thought given to 

an object’s recognisability from a distance, 

so a character is easily recognised from far 

away

• It lets you concentrate on one aspect of 

design at a time – you don’t need to worry 

about anything else other than the overall 

shape of the silhouette, the emotional 

response from the viewer and whether that 

response is the desired effect based on the 

design requirements

Of course, once the external shape of the 

character is agreed upon, it’s time to fill in the 

internal details. This involves the reconciliation 

of external shapes, with associated internal 

objects which also serve a functional purpose 

for the character in question. There’s no real 

‘right’ way to go about this, but a good rule I try 

to keep is to concentrate on the larger shapes 

before going into the minute details; it’s a very 

fluid natural progression when you think about it.

Silhouette Detailing – So here is an example 

of how a character’s silhouette is taken from an 

abstract silhouette, to a fairly well fleshed-out 

concept (Fig.05).

I chose this particular pose because I like its 

dynamic nature; I felt it had lots of possibilities 

to explore and so I increased the resolution and 

began by working in the large shapes roughly, 

using the same basic brush that I began with.

When I was happy with the overall shapes, 

I began using a soft edged airbrush in order 

to give the shapes form and roundness, and 

I envisioned the light source from a frontal 

raised position. Picking out your light source 

will answer many questions regarding form, 

so always keep this in mind early on in the 

rendering process.

The advent of digital art making has many 

boons: the ability to revert to a prior state; the 

efficiency of automation; the ability to paint full 

colour pictures without waiting for paint to dry 

nor having to inhale fumes from solvents. 

In the field of concept art, another very 

time-efficient advantage is the ability to non-

destructively create numerous versions based 

on the same idea. 

Versioning – You can see from Fig.06 that the 

base image is the same; however, because I 

have duplicated the image twice, I negate the 

requirement to think of new poses, and the 

proportions of the figure have already been 

taken into account with the first character on 

the left. This means that for the two characters 

on the right of the original, there is less to think 

about, and more effort can be put into things 

such as the accessories of each.

As you can imagine, the advantages are huge 

and very economical if you want to create a 

large number of variations based on a single 

silhouette or body type. All that is required is the 

duplication of the image layer you want to work 

with, and simply painting over the top of it.
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The advantages are huge, and very economical 

if you want to create a large number of 

variations based on a single silhouette or body 

type. All that is required is the duplication of the 

image layer you want to work with and simply 

painting over the top of it.

Custom Brushes
These days, custom brushes seem to be a 

staple of most digital artists’ tool boxes. They 

are one of the aforementioned benefits of the 

digital age of art making, the process is simple 

and makes creating repeating elements a 

breeze.

However, this tutorial isn’t going to cover custom 

brushes. 

Yes, I know – huge riots, controversy and all 

that – but the truth is I just don’t use custom 

brushes for the idea generation process much 

at all (final piece artwork is a slightly different 

story, though). There are some artists out 

there who swear by them because of ‘happy 

accidents’, just as there are some, such as 

myself, who would rather make every stroke 

deliberate. It’s not that I can’t use them or don’t 

know how to make them, but I just prefer the 

control over my work using a regular default 

brush.  Neither workflow is right nor wrong; it is 

a personal choice. My thoughts are that if you 

feel comfortable using something and you can 

deliver the results, your methods work for you!

That being said, because I see such an over-

reliance on custom brushes by many novice 

artists, I’d like to explicitly remind people reading 

this that a custom brush is 

nothing but a tool. Like 

all tools, there are 

moments when they 

should be used, and 

moments when they should 

not be used. Custom brushes 

should never be used to 

replace the basics of art making 

and, if worst came to worst, you 

should be able to illustrate your thumbnails and 

silhouettes without them at all. Once you can do 

this, then using custom brushes may speed up 

your work, but as always: basic art skills first, 

flash-tastic technology second.

I’m not trying to discourage the use of custom 

brushes, by all means I encourage you to try 

them as well as many other work methods, and 

you might just find they gel with your working 

style – they just don’t work with mine at this 

current time.

Rules and Guidelines
When it comes to art, many feel that rules inhibit 

the artistic expression of some artists. If you 

want to be a commercial artist, you’ll need to 

kick that idea right out of your head. Creating 

art in a commercial environment has plenty 

of constraints which can be bent at times, but 

certainly not broken, especially if you’re not the 

art director.

These are a few that pop up frequently, so try to 

keep them in mind when you do your work:

• Function before form: It is of absolutely 

no value to your employer, your client or 

your art lead if you create art that is flash 

over substance. The functional value of the 

costume needs to be there; once it suits the 

purpose it was built for, then you can make 

it look cool. One big example is articulation; 

I see a lot of artists creating these hulking 

power suits that look cool but are completely 

impractical and the wearer would simply 

not be able to lift their arms high enough to 

scratch their own heads!

• Rely on pre-existing memes to present 

your ideas: Rely to an extent on what has 

come before in the design world. Red means 

stop or danger, green means go, sharp 

means dangerous and round and soft means 

harmless and user-friendly. Leverage these 

memes and archetypes to give credibility to 

your designs

• Don’t ‘ape’ other people’s artwork: Don’t 

steal, copy, or plagiarise other people’s 

designs. Just don’t!

Mindset
I’ve always been one to insist that what goes 

on in the head of the art maker is equally, if 

not more important, than what happens at the 

business end of a pencil. While I’ve alluded 

in various places during the tutorial what I am 

thinking, here are some of my thoughts on what 

you should try to keep in mind while you are 

exploring your ideas on paper:

• You are creating many tiny inconsequential 

pieces of art: the more you create, the higher 

the likelihood that you will have within those 

drawings the elements of the final design

• You are unbiased towards any one design 

because Murphy’s Law will almost always 

guarantee that the design that least excites 

you will be chosen by the art director

• Every single sketch, thumbnail, silhouette 

or scribble is valuable – don’t erase them

• Any idea is a good idea; within each sketch 

holds a key that could open another door 

which may eventually lead to the final design

So here you are at the end of my write up. I’m 

sure you’re itching to get to some thumbnails 

underway – that’s if you haven’t already!

I hope you’ve enjoyed my tutorial and hopefully 

picked up one or two pointers. If you have any 

questions or comments please feel free to send 

me an email. Until next month: keep 

drawing!

Darren Yeow
For more from this artist contact 

them at:

darren@stylus-monkey.com
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This Workshop Series will look at, just as the title suggests, all the 

things that we need to know to get us started with Photoshop – mainly 

for painting, but also for other things such as matte painting and photo 

manipulation, which often use the same tools. We will be covering all the 

technical aspects of the programme, as well as some technical sides of 

painting that’ll help us starting to swing the virtual brush!

Chapter 1 – July 

Introducing Photoshop’s Workspace, Graphics Tablets, Screen 

Calibration, Color Profiles and the Brush Tool. In the first chapter we 

will be looking at organising Photoshop’s Workspace, setting up the 

programme for optimal usage and setting up a tablet to work with it, 

calibrating your screen, choosing colour profiles in Photoshop, as well as 

what to do with the Brush tool and its many options.

Chapter 2 – August 
Canvas Settings, Scanning Drawings, Swatches, Colour Pickers,  

Colour Theory, Layers and Custom Brushes!

Chapter 3 – September
Composition Rules, Sketching and Perspective, Understanding  

Light and Blocking-In

Chapter 4 – October
Colouring from Greyscale, Colours beyond Blocking-In, Blending  

Methods and Using Photos

Chapter 5 – November
Quick Masks, Using the Wand Tool, Liquify Filter uses, Layer  

Masks – and Painting!

Chapter 6 – December
The Final Part: Finishing Touches, Filters, the Unsharpen Mask  

and Saving your Work
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Created In: Photoshop

Introduction
I remember what it was like for me to see digital 

paintings for the first time: I was dumbstruck, 

possibly in awe as well. And of course 

wondering how the heck anyone could do that 

… With a mouse! Until someone told me they 

used a ‘graphics tablet’. More awe and wonder. 

And intrigue. So it was actually possible to use 

Adobe Photoshop (or PS for short) for painting. 

How was a mystery to me, but I was determined 

that it wouldn’t stay one for long. So I grabbed 

myself a wee-tablet – a Wacom Graphire, the 

first one that came out – and set to playing 

around in Photoshop. Thankfully, I’d used the 

programme for a couple of years previously, as 

otherwise I would have probably despaired.

Since then, I’ve met many people who were 

and are just as dumbstruck as I once was, and 

annoyed that they cannot seem to get the hang 

of either Photoshop, a graphics tablet, painting 

with either one for that matter, or any tutorials 

that could help with starting out. So this is 

where this 6-part series of workshops comes in: 

To unravel the mysteries of Digital Painting in 

Photoshop, using a graphics tablet.

In these workshops, we will be going through 

setting up PS and a graphics tablet for optimum 

usage, learning about brushes, sketching, 

colours, composition, perspective, layers, 

textures, lighting, different tools and filters – you 

name it! Please bear in mind that this is a more 

technical series, and will not be dealing with 

how to paint one thing or another, although I will 

brush over things occasionally (excuse the pun).

This first instalment, which seems awfully long 

but will only take you a maximum of 15-minutes 

to actually apply, will be dealing with the, let’s 

say “duller technical things”. However, you will 

need to know about these in order to get you 

started – and hopefully hooked!

In the Beginning...
Adobe created the perfect painting platform, and 

Wacom coined temptation in feature-packed 

graphics tablets. Put the two together and you 

get the Big Bang of digital art, or something 

along those lines. 

But before I dig into the inner workings of both, 

let’s just check that we are on the same page:

• Photoshop Version

I have Photoshop CS. A few years old now, 

but that doesn’t really matter. For the tools 

I use on a regular basis I don’t need the 

newest version all the time. So don’t worry 

if you have an even older version (though 

anything older than Photoshop 7 might 

pose a problem for some of the things I’ll 

be explaining). If you have a newer version: 

lucky you – you’ve got a slightly more 

streamlined layout and additional tools that 

we won’t be using [Wink].

• Graphic Tablets

I am working with an almost 6-year-old 

Wacom Intuos 2. These things don’t break 

that easily, unless you happen to have a 

chew-happy rodent as a pet – the cables 

cannot be replaced. Whatever tablet you 

have, even if it’s not a Wacom, you’ll be able 
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to work with it. Honestly. If you’re not really used to it just yet, plug in 

your mouse and navigate Photoshop as we go along.

So let’s open up Photoshop and see what we’ve got. This would be 

the default look of the programme, more or less (Fig.01). It’s called the 

Workspace. You have the tools palette to your left (hovering over each 

tool will give you a short description of what it is), some other palettes to 

your right, the main menu at the top, and a status bar at the bottom. All in 

all, a quite convenient layout!

The first thing we do before hitting the panic button and closing PS again 

is the most important thing we could do: we will set up the Scratch Disks. 

– The what? – Scratch Disks. These have nothing to do with scratching, 

and are not real discs either. They are a bit like virtual memory, settings 

that allow PS to run smoothly, and at its best according to your computer’s 

RAM (Random Access Memory) and processor speed. Without setting 

these up, you will get quite a few programme errors very soon, including 

one telling you that “the Scratch Disks are full” and whatever you wanted 

to do cannot be done.

Therefore, let’s go to the main menu and click on Edit. In the dropdown 

menu that appears go right to the bottom and click on Preferences, then 

in the next dropdown menu click on Plug-Ins & Scratch Disks… (Fig.02). 

(I believe in higher Photoshop versions this will be “Performance”.) A 

box will appear that gives you four rows for the Scratch Disk usage. The 

first one will by default be set to Startup, while the other three are empty 

(Fig.03).

Now, to run PS properly you do not want the Scratch Disks set to Startup. 

It’s also recommended that they shouldn’t be set to a network drive or any 

kind of removable drive (USB sticks or external hard drives). So click on 

the arrow next to it and it will give you a choice, namely of the hard drive 

volumes you have on your computer (Fig.03a).

You can see for me it shows C:\ and K:\ – the latter being my external 

hard drive, and of absolutely no use in this case. C:\ usually is the drive 

or partitioned volume that your operating system and programmes are 

installed on, and that your operating system uses for its virtual memory or 

paging file. In many cases, especially on cheaper computers, it is also the 

only drive/volume you will have. If you have a partitioned hard drive, that 

means you have two volumes, and thus will also have something most 

likely called D:\, or if you have more than one installed hard drive these 

will show as well.

Let me stop being confusing for a second and spell it out plainly: For 

optimum performance of Photoshop, the primary Scratch Disk has to be 

set to a drive or volume that has sufficient space and is kept in good order 

at all times (defragmentation is your friend). If you have more than one 

volume, the primary Scratch Disk should be set to the bigger one of the 

two – you can check up the sizes of your volumes under My Computer – 

while the secondary to the smaller one. Those of us with only one volume 

are a bit out of luck right here ... we’ll still be able to work, but maybe not 

as fast as some others. Set your Scratch Disks (Fig.03b). 
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are running at the same time, the more RAM will 

be used up by them and cannot be used by PS 

– and using the slider change it to what will suit 

you and your computer best. I’d recommend not 

setting it to 100% (Fig.04a).

Another good thing to set up here are the 

History States. You can find them in the 

dropdown menu under General. The History 

States are the stages in your image history 

when you are working which let you go back 

if you’ve made a mistake – you know the 

infamous “Undo” button. 20 may look like a lot, 

but when you are painting sometimes that isn’t 

quite enough, especially when you are doing 

very detailed things with lots of brushstrokes. 

I personally prefer having it set to 40 – just in 

case (Fig.05).

You can now hit the OK button. The changes 

we’ve just made will not take effect until PS is 

closed and restarted. We’ll do just that.

TIP: If you can afford it, and are serious about 

working with Photoshop, have another hard 

drive installed in your computer which you can 

use just for Photoshop’s primary Scratch Disk. 

Or see if someone can partition your hard drive 

for you. If none of that is an option, keep your 

drives as clean as possible by defragmenting 

them regularly and preferably storing personal 

files on removable media rather than on your 

computer. I do that at the moment, and it works 

a treat.

Let’s stick with this box for a second and open 

the dropdown menu at the top of it. It basically 

gives you the same choices as when clicking 

Preferences from the main PS menu. Click 

on the Memory & Image Cache option. This 

will give you the chance to enhance the RAM 

usage of Photoshop (Fig.04). By default, it 

will be set to 50%. Consider how many other 

programmes you will be using simultaneously 

while running PS – the more programmes that 

Once we’re back in the programme, let’s have 

a look at the Workspace. Some of the things 

that are hanging around by default won’t really 

be needed, or at least I never make use of 

them. Also, having all those palettes to the 

right clutters up the Workspace a bit, giving you 

less space to use for your images, especially 

when working on smaller screens. Looking at 

the palettes (Fig.06), the one right at the top 

reading Navigator, Info and Histogram, I never 

use, so I just click the red X of doom and close 

it. The Navigator can be useful when working 

on large images, but I will explain that at some 

later stage – right now it would be too much too 

fast for those of you who are really new to all 

this. The next one down, with Color, Swatches 

and Styles, is partially useful. Click on the 

Swatches tab and hold it, then drag it onto your 

Workspace (Fig.06a); it will become a palette all 

by itself. Then close the palette you just pulled it 

out of. Do the same with the next one, keeping 

the History, but not the Actions, and the next, 

keeping the Layers, but not the Channels or 

Paths. This leaves us with three palettes that we 

will definitely be using. 

Next up, look at the grey area above the 

palettes; this is the docking well. There are 

some more tabs reading Brushes, Tool Presets 

and Layer Comps. You can click on a tab to 

open it, or in this case click and hold, then drag 

the tab onto your Workspace (Fig.07). Do this 

with the Tool Presets and Layer Comps - close 

them. Now click and hold the tabs in the palettes 

still on your Workspace and drag them into 

the docking well to dock them, freeing up the 

Workspace (Fig.08).
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Of course, you don’t have to do this, but I often feel the more space the 

better. And don’t worry: the palettes we’ve just removed are not gone 

forever! You can call them up again by clicking on Window in the main 

menu (Fig.09) – all the ticked palettes are currently active, while the un-

ticked ones are not. “Options” represents the bar under the main menu, 

including the docking well. At the bottom of this list you also find the Status 

Bar; if you feel you don’t need to see how long PS is taking to process 

something, or don’t need the little tips on how to use the tools that show 

up in it when a tool is selected, simply un-tick it, thus freeing up even more 

space at the bottom of your screen. To save these Workspace settings, 

just go to Window > Workspace > Save Workspace... (Fig.09a) and 

call it whatever you like. Not doing this may reset your Workspace to its 

default layout once you’ve closed PS.

We’re almost done with setting up PS now. However, there is one more 

thing: colour management. This may not seem too big a deal to most 

people, but when you are painting, and especially when painting for print, 

it is. We can do this here: Edit > Color Settings.... 

A box will pop up (Fig.10). I don’t know what the default settings here are; 

as you can see I’ve already set my colour profiles up. Tick the box next 

to Advanced Mode – this will give you more options. I’ve got my Working 

Spaces set to sRGB, but another setting called AdobeRGB works too. 

The reason I have mine on sRGB is because I like saving my paintings 

for viewing on the internet without loss of colour, and found that if I set my 

Working Space Profile to AdobeRGB it greys out the colours of paintings 

saved for the web. Don’t ask me why – I don’t’ know. 

All in all the settings are quite straightforward, but here you could in 

theory set the profiles for certain things, for example if you have been 

commissioned by a publisher to paint something for print and they have 

specific requirements. The profiles you choose here correspond to 

different settings of printers. If you were to paint a picture in RGB, but a 

printer is set to CMYK, you will notice a difference in colours, which is not 

always favourable. Once you’ve finished setting things up, click Save and 

give your custom profile a name.

Next up, go to the main menu and click on View > Proof Setup > 

Custom. Another box will pop up. I’ve already set mine (Fig.11). You’ll 
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see in the dropdown menu you will have a lot of options. Choose the 

same colour profile you chose before. You can also save this and call it 

whatever you want.

Sticking with colours, most screens these days are pretty good with them. 

Some – namely laptop screens – are terrible, or at least I yet have to find 

a laptop that gives me good colours without adjusting them. Another thing 

I’ve found is that glossy screens (the shiny ones, looking all pretty and 

stuff and great for leaving fingerprints on) are also not that great when it 

comes to using them for painting, because they tend to make dark colours 

appear a little lighter than they should be due to the reflection and “crystal 

bright” technology these things advertise. But that’s just me.

TIP: By the way, did you know that it’s not very good to paint digitally in 

a completely dark room? The lack of surround light makes the colours 

seem a lot more vivid than they actually are, thus making fine nuances, 

especially in dark colours, more apparent. Also, it’s not good to have your 

computer opposite a window or strong light source. The perfect position 

for a screen is against a wall, with soft but adequate light coming either 

from the left or right.

Anyway, colours ... Something you may want to do, no matter how brilliant 

you think your screen is, is calibrate it. Calibration means adjusting the 

screen so it gives you the closest match to actual colours as possible – 

useful for print. You can do this with Adobe Gamma, a programme that 

usually comes installed on your computer upon purchase, at least on a PC 

anyway. You can find it in your computer’s control panel. If you’re using 

Vista like me, click on “Classic View” in the side panel – you will then find 

Adobe Gamma in the top row (Fig.12).

If you click on it, you will get a pop-up box that offers you a couple of 

choices: Step-by-Step Wizard, or setting it up manually in the control 

panel. The wizard is pretty good, so go with that one as it explains the 

different steps to you. In the next window you will need to choose a 

colour profile – load the same one that you’ve chosen in Photoshop. The 

next one is pretty self-explanatory; just do what the programme tells you 

to do. The next one will ask you to set the Phosphores. Do not change 

anything there unless you know what is set by default to be wrong. The 

next window asks you to adjust the Gamma. Do this according to the 

explanation, and then set the Gamma at the bottom to 2.20. Next up is 

the Hardware White Point. You can measure it – and that’s actually quite 

fun. Just follow the instructions on the screen. Some screens are naturally 

warmer than others when it comes to colours, meaning that their whites 

will seem yellow, rather than blue, which would be cold. Adjusting this 

helps a lot, as you want a neutral colour appearance, however it can also 

totally derail your colours for other people when they view your paintings 

on their screens which will not be the same as yours. The next window 

lets you Adjust the White Point. Just set it to “Same as Hardware”. And 

the next window lets you see what things looked like before, and after. If 

you are happy with the result, click on Finish and save your profile under 

a new name. 

Great! That’s all that out of the way. Go make some tea or coffee, you 

deserve it (and will need the caffeine to keep yourself awake whilst 

following all this technical stuff, no doubt).

What’s next? – Your graphics tablet. Wondersome things, they are. I 

tend to say that the pen behaves like a retarded pencil, especially when 

you have one with a plastic nib (which is usually the default nib). But 

no worries, if you’ve never used a tablet before, or disregarded it as 

something you cannot possibly work with, try again – you will get used 
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lets you select or browse your programmes 

(Fig.13a). Browse your folders for Photoshop 

– you will usually find this here: Computer > 

C:\ > Program Files > Adobe > Photoshop > 

Photoshop. Hit Open. Photoshop will now show 

as a path in the Selected Application at the 

bottom of the box. Click OK. – PS will now be 

listed in your Applications (Fig.13b).

To set up your tablet for PS, click on the 

Photoshop icon in your Applications. First up, 

make sure to set up your pen’s Sensitivity 

or “Tip Feel” – I’d recommend setting it to 

something softer, rather than firm. This will 

make it easier to paint, as you won’t need to 

press down so hard on your tablet that you 

end up scratching the surface! These settings 

are different for everyone, so I cannot tell you 

more than that; play with it, see what you like 

best. For more options on that one, click the 

“Details” button. A new box will pop up where 

you can even try and scribble something, and 

the driver will adjust the settings for you, though 

to it, and painting with a mouse is a recipe for 

wrist cramps. It just takes a bit of practice. You’ll 

never want to see your mouse again after a 

while.

Wacom has many different tablets to choose 

from, so pick carefully. Yes, the Cintiq looks 

cool, but it still won’t make you a better painter. 

And no, you don’t need a massive sized tablet 

just because you have a massive screen. It also 

doesn’t really matter if you have a widescreen 

monitor but not a widescreen format tablet. 

Whatever you’ve got, it will work. 

So, you’ve got your tablet plugged in and your 

pen poised. Use the disk – if there was one – 

that came with your tablet and install the drivers. 

– Don’t have the disk anymore? Go to the 

Wacom website and download your driver. Your 

tablet does work without one, but it will act like a 

mouse rather than a tablet, and that’s not what 

we want here.

Open the driver for your tablet; you will find it in 

the Wacom folder in your Programmes folder 

(Startup > Programs...). My tablet setup menu 

may look different to yours, but the basics are 

the same (Fig.13). At the top it shows you the 

Tablet you’ve got, beneath that are the Tools, 

and beneath that the Applications.  Select the 

Grip Pen in the Tools if it isn’t already selected, 

and in Applications we have to add PS. To 

do this, click on the + (or on “Add” depending 

on your driver menu) next to the Application 

row. This will open another small window that 

I find it’s not always very accurate. The settings 

I normally use make the pen strokes seem 

stupidly soft (Fig.13c). When you are done with 

that, click OK to close the box. Staying with the 

Pen tab, you can also set up the buttons on 

your pen – there are dropdown menus for both 

the top and bottom one. I have a tendency to 

accidentally click the bottom button when I work, 

so I choose to disable it. However, a right-click 

is always useful, also when working in PS, so 

the top button I set to that (Fig.13d). Also make 

sure to set up the Eraser in the same way as the 

pen, in the Eraser tab. Once you’re done with 

this, you could close the tablet driver Window 

without further ado. But – and there is always 

that niggling little but – checking all the other 

settings and adjusting them to your preference 

is something you may want to think about. 

Like having a look at the Mapping tab – this is 

quite important as it lets your tablet correspond 

to your screen, or portions of your screen, or 

even two screens (Fig.13e). The settings you 

see in the Fig.13e are the ones I recommend. 
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navigate through the menus. However, I never 

use my keys – force of habit. Someone buy me 

an Intuos 4 and I will.

Oh, and you can of course repeat all this for “All 

Other” applications, and add more programmes 

to the list, too. I find it useful to set the pen up 

for All Other as well, because I use my pen for 

everything, including browsing.

TIP: When navigating with the pen – browsing 

or within Photoshop – you don’t need to drag it 

over the tablet’s surface and in repeated strokes 

at that, as though you’re using a mouse. You 

can just hover with the pen over the tablet to 

move the cursor, or lift it up completely and 

set it down somewhere else to get your cursor 

there. And if you’re wondering how to do a click 

or double-click without using the pen button, try 

tapping your pen on the tablet. Tapping once 

is a click, and tapping twice double-clicks. Ah, 

and I know this may seem like a stupid thing to 

say, but you can put your hand on the tablet like 

it is a piece of paper when handling the pen, 

even if it’s a Cintiq (though you may want to 

wear a half-glove for that one to prevent hand- 

and fingerprints).

Now that we’ve got the rather tedious stuff out 

of the way, let’s head back over into Photoshop 

for a little while before I draw this chapter to a 

close. 

I 

Ticking the “Force Proportions” box means your 

screen shape (widescreen, square, etc.) will 

force itself on the tablet surface, which usually 

results in parts of your tablet being cut off and 

thus rendered useless. And no, as said before, 

it doesn’t matter if you have a widescreen but 

your tablet is square: a perfectly drawn circle will 

not suddenly become an ellipse on your screen 

if you don’t force the proportions.

You’re technically done now, and can close 

the driver window (you may have to apply the 

changes in certain cases first), but you could 

also set up your shortcut keys if your tablet 

has those. For mine, there isn’t much setting 

up to do, rather a decision to be made if I want 

them activated. To do this, click on Functions 

in the Tool row, and select Photoshop in the 

Application row (Fig.13f). At the bottom you 

have two tabs, one for Tablet Menu, the other 

for the Pop-up Menu. Choose the Tablet Menu, 

and there you should be able to set up your 

shortcut keys. If you have an Intuos 2 that is 

smaller than A4 (like me), you won’t see any 

shortcut keys printed on your tablet surface, but 

if you hover the pen along the top edge of the 

active surface you will notice some “keys” pop 

up in the top part on your screen going from 1 

to 13. Newer tablet versions have actual keys 

on the tablet. These can be useful when you’re 

working in PS as some major functions are 

applied to these keys, and it saves you having to 

originally wanted to explain some canvas 

settings here, but decided that it can wait until 

the next chapter. Not because it’s not important, 

but because it would most probably bore the hell 

even out of myself right now. Besides, I’d rather 

give you something in closure that you can play 

around with until the next instalment: brushes, 

and how to use them.

Before we can play with brushes, we need to 

open a new file, and to do that we simply click 

on File > New.... A box pops up showing the 

dimensions and other settings of the new file we 

are about to create. The Default Photoshop Size 

is rather small to work on, even when not really 

working on anything in particular, so click on the 

arrow next to the Preset and choose something 

else (Fig.14); Letter is a nice size for practicing 

on, or A4, or if you‘d rather have it smaller 1024 

by 768 pixels should be an option, too.There are 

some more settings, I know, but as said before 

we will ignore these for now. If your Background 
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on will be your most treasured tool of all. It is 

magic, and you’re on your way to making that 

magic happen now!

Nykolai Aleksander
For more from this artist visit

http://www.admemento.com/ 

Or contact them at:

x@admemento.com

the right-click thing and don’t know how to get 

the Palette off your Workspace, try tapping your 

pen once on an empty spot on your Workspace. 

I love using this second method as it saves me 

having to move my hand off the canvas. Those 

of you with newer tablets than me are lucky, 

because you have the aforementioned preset 

buttons on yours.

Anyway, the Brushes palette! Once again, I 

will go into using this to full advantage in the 

next instalment, but for now I want to stick to 

the plain old round Paintbrush anyway, as it 

best shows all the things there are to know 

about Brush Settings. Now, there are lots of 

different settings for your brushes, and I will not 

go through all of them as many are quite self 

explanatory, and besides, where‘s the fun if you 

don’t discover things for yourself? However, 

covering the ones that are most useful and most 

often used in painting, I will explain – in pictures. 

Because it’s better to show than just to tell you, 

and you won’t have to go searching for the 

corresponding figures this way [Grin].

After selecting a round brush, clicking on the 

Brushes tab in the docking well will pull up the 

Brush Settings:

The work has only just 
begun…
In next month’s issue I will be showing you how 

to adjust Canvas settings, as well as the most 

widely used settings for scanning drawings 

and adjusting them to work further on them, all 

about the use of Layers, how to work with the 

Swatches and the Color Picker, how to choose 

the right colours and make them work, as well 

as how to create your own custom brushes and 

what you can do with them.

But right now, it’s time for you to play with what 

you’ve learned so far. And when I say play, I 

mean play: just go wild with the Brush Settings 

and try everything. This will not only get you 

accustomed to each one of the settings, but 

also get you used to your pen, which from now 

Contents are set to Transparent, you will want to 

change this by using the dropdown menu next 

to it (Fig.14a).

Now that we have our canvas ... Wait, a couple 

of things first to keep confusion away: The 

canvas will most likely be shown scaled to fit 

onto your screen, and you can change that 

by going to View > Zoom In/Out – there are 

shortcuts for this too, which are noted next to 

the actions and can save time. I will not mention 

every shortcut there is; you have eyes, you 

can read (Fig.15). And to choose or change 

the colour you are going to paint with, you can 

do two things: either just call up the Swatches 

Palette in your docking well and pick a colour 

from that (more on that in later chapters), or 

... see the little squares at the bottom of your 

tools palette? The one on top is your foreground 

colour (that’s the one your pen uses), the one 

behind it is the background colour. To exchange 

the two, click on the little double arrow. To 

change your painting colours, click on the 

foreground colour square and you get your 

Colour Picker. You can pick your shade in the 

square, and with the slider next to it you can 

move through the entire spectrum of colours 

(hues) available (Fig.16). When you’ve picked 

your colour, simply hit the OK button. Easy!

Right then, where was I? – We have our canvas, 

and colours, now we need brushes. Select the 

Paintbrush in your tools palette. 

Try scribbling something on the canvas – if 

it feels too hard, change your pen settings to 

something softer, and vice versa. And if you end 

up with a dotted scribble rather than an actual 

smooth line, this is due to the brush settings 

which we shall have a look at now. Bear with me 

here, it may seem a bit complex as I will try and 

explain everything, but isn’t really.

To choose a brush you can do two things: you 

can either click the arrow next to the Brush in 

your Options bar (Fig.17), or right-click on your 

canvas and the Brushes palette will magically 

appear floating on your Workspace. If you did 
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We are pleased to present an exclusive article on the making of 

Jason Seiler’s Aretha Franklin caricature. Jason takes us step-by-step 

through his painting process in Photoshop, from sketch to final piece, 

and we will also be welcoming him back to 2DArtst later this year for 

an interview – that’ll be a treat for sure, as his portfolio contains some 

of the most stunningly painted caricatures you could hope to find!

“I wanted to end up with 
a warm painting, as well 
as a painting that looks 
and feels like a piece 
of art, rather than a 
manipulated or distorted 
photograph.”
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The brush I started with was a size 13 round 

brush (Fig.01a – 01b). I made sure that Other 

Dynamics was turned on and that the Opacity 

Jitter was at 0%; Control was set to Pen 

Pressure, Flow Jitter set to 0%, and the Control 

below the Flow Jitter was turned off. These 

settings gave me the control that I prefer. I 

usually paint with my Opacity set to 85-90% and 

my Flow set to 100%, although this sometimes 

differs depending on effect.  

I made sure that Shape Dynamics was turned 

off. The flesh colour I chose to use in RGB 

Mode was R: 190, G: 124, B: 104. I don’t always 

start with this colour. In fact, I rarely start with 

the same colours twice because each subject I 

paint presents a new mood or feeling that I want 

to capture. 

My photo reference had unnatural lighting and 

felt too pink. I knew from looking at my reference 

that I wanted to go in a different direction; I 

wanted to end up with a warm painting, as well 

as a painting that looks and feels like a piece 

of art, rather than a manipulated or distorted 

photograph. So I chose a violet red colour (R: 

Created In:
Photoshop

Introduction
These are the steps I took while painting my 

recent caricature, ‘Aretha Franklin’. The sketch 

was drawn in Photoshop (Fig.00), using a small 

round brush. For the painting I used Photoshop 

CS and a Wacom Cintiq; the size of the final 

painting is 13 inches wide by 14.5 inches high, 

at 300 dpi resolution.

Step 1
After I finished my sketch, I chose Select All, 

copied that layer and pasted another copy of the 

sketch above the background layer, one above 

the other. I then switched to my background 

layer, hit Select All again and deleted the sketch 

from the background layer. I then selected Layer 

2, which had the sketch on it, and set that layer 

to Multiply. 

I painted in a flesh tone directly under the 

sketch layer so as not to lose my sketch lines. 

“I rarely start with the same 
colours twice”
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98, G: 17, B: 25) that I essentially filled the 

background with. I didn’t want any whites in my 

painting just yet. Because I tend to paint from 

dark to light, the background here was used as 

a foundation to build from.    

I created a palette layer at this point (Fig.01c). 

It’s important to create a colour palette that 

has harmony. My main priority was getting the 

values right and I knew that if I could succeed 

in that, I could do just about anything with 

the colour. When I paint, I usually create a 

variation of red, yellow, and blue. With these 

three colours most colours can be created. 

You’ll notice that in this painting my colours are 

very warm: reds, oranges, browns, violets, and 

greens.  

To create my palette, I made a new layer that 

would remain on top of all the layers from this 

point on. This layer was used as my ‘palette 

layer’. I selected my Eyedropper tool and picked 

a red-brown colour from my background. I then 

clicked my colour picker and chose a few more 

reds based off the red-brown that I chose, and 

then I created a small grouping of flesh-like reds 

and browns. I did this by squinting my eyes while looking at my photo 

reference, and then choosing colour according to the values I saw while 

squinting my eyes.  When I looked at my photo reference through squinted 

eyes, I saw reds, greens, violets, and blues, but I knew that I wanted a 

warmer painting for my final. So I create those colours and mixed my 

red-brown colour into all of them, creating harmony. This technique was 

similar to the ‘pigment soup’ technique that I sometimes use when painting 

with oils. 

Step 2     

What I typically do at this stage is use my Eyedropper tool to select the 

colour I’ve created for the background, and then use that colour to begin 

my block-in (Fig.02a – 02b). At this stage of the painting, I was mostly 

concerned about painting the correct values. It was also important, at this 

stage, to not zoom in too close. I chose to paint from a distance and used 

large brushes. This way I could focus on capturing shape and values, and 

merely suggest detail.  

“Think of it as if you are sculpting, 
chipping away small pieces”
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Next, I created a new layer on top of the other 

layers and began to slowly paint over my 

sketch lines. By this point I’d created enough 

form and structure that I no longer needed my 

sketch lines. I also began to block in a bit of 

the background as well. The background was 

important to establish early on in the painting; it 

had to complement the portrait. The colours and 

values of the background will affect the colours 

and values in your portrait, so it’s important to 

work back and forth between the portrait and 

background while blocking in. Think of it as if 

you are sculpting, chipping away small pieces 

until the form appears. 

I usually save my bright highlights and whites 

for later on in the painting and start first by 

establishing my darks and working lighter from 

there. This stage is simply for me to create a 

balanced foundation for my block-in. Steps one 

and two take five to ten minutes – at most – to 

complete.  

Step 3     

I created another layer that would go directly 

under my “palette layer” but would remain on 

top of all the other layers. I began to paint on top 
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of my block-in; everything up until this point was 

used as a guide for me to follow as I built up 

layers of colour.  

Next, I needed to establish my darkest darks 

and block those in. There was no need to zoom 

in; I worked at a distance and continued to use a 

large round brush. My technique when painting 

digitally is very similar to how I would paint 

traditionally with oils: start with bigger brushes, 

blocking in the largest shapes of darkest colour 

and value; as the painting progresses, I use 

smaller and smaller brushes. Also, I never 

stay in one area for too long. Painting from a 

distance with larger brushes helps you cover 

more ground in less time.

I established my darkest darks and at this point 

began to paint lighter values on her face and 

chest (Fig.03). I also started adding lighter, 

almost pure white value on her clothing. Notice 

that I have not yet added any such values to her 

face, as I saved those highlights and reflective 

lights for later on. It’s easy to become impatient 

and want to paint in highlights right way, but it’s 

better to not get distracted by them and wait. 

The reason I painted the almost white values on 

her clothing was so that I could later compare 

the lighter values in her face to the values on 

her clothing. I knew that there should not be any 

area on her face that shared values as white as 

those which exist on her clothing.  

Step 4     
As I continued to block in the painting, I found 

myself unsettled with the composition. This is 

one of the great things about painting digitally. 

With the Crop tool, I selected the entire canvas 

and then added a bit more to the bottom, giving 

Aretha additional girth (Fig.04).  

Step 5     
As the painting developed I continued with the 

same approach, squinting my eyes and mixing 

http://www.2dartistmag.com
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colour to match the value and temperature that I 

desired for the piece. Still using a round brush, I 

began to zoom in to paint details. I then started 

to refine the mouth, eyes, nose, ears, and hair. 

You can start to see a softer transition on edges 

between values (Fig.05).   

 Step 6     

I removed the palette at this stage because I 

had enough colours in my painting to work with. 

If I needed to change the value or saturation 

of a colour that I already had, I simply clicked 

on the colour picker and mixed or adjusted my 

colour there. Not much here has changed since 

Step 5 (Fig.06). 

I began to use my favourite Photoshop brush, 

#24 (follow the brush settings mentioned in Step 

1). Brush #24’s marks and strokes feel more like 

a natural paint brush and I use it as such. This 

was the brush I used to finish the painting, with 

the exception of a soft round that I used for hair.  

Step 7     

I began to focus my attention on Aretha’s face 

(Fig.07). Adjustments were made to her nose 

and right cheek, and I noticed that I could 

exaggerate her mouth a bit more, so I painted 

away the mouth and re-painted a new mouth 

lower on her face. This added more space 

between her nose and mouth, which is what I 

wanted. I also extended her mouth and bottom 

lip out a bit further, which enhanced both the 

likeness as well as humour. I continued to soften 

edges, adjust values and introduce additional 

lighter values to her face and clothing. I also 

began to soften her chest and hair.  

Step 8    

At this stage I freely zoomed in and out – 

zooming in for details, zooming out to have a 

look from a distance. It was important to often 

step back from the painting. With this painting 

it was not my intention to copy the colour I saw 

in my references. Instead, I wanted to focus on 

values and colour temperature. Squint your eyes 

for value, and open your eyes to see the colour. 

I basically finished the face at this stage, and 

started to detail her chest and clothing (Fig.08).    

Step 9     
The painting was all but finished in this final 

step, with the exception of the hair and minor 

details of clothing and composition. For the 

hair, I created a new layer. This way, if I needed 

“Squint your eyes for value, and 
open your eyes to see the colour”
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to erase a section of hair that didn’t feel right, 

it didn’t ruin the rest of the painting. I painted 

the large mass of value and shape that I saw 

while squinting my eyes. I then blocked in the 

basic form or design of the hair a little bit darker 

than it needed to be. This way, when I painted 

smaller hairs on top, in a lighter value, it gave 

the illusion of depth. To add to this illusion, I 

also changed the size of my brush to differ the 

widths of the hairs. I used a Soft Round brush 

with a tapered point to paint smaller hairs. Keep 

it simple: study what hair does and then make it 

more interesting. 

My goal with this painting was that it would feel 

more like a traditionally painted piece, rather 

than a digitally painted image. To get a more 

traditional look for the piece, I selected some 

texture from one of my oil paintings and dragged 

it on top of my painting. In my layers window, 

I selected Hard Light and set it to 47%. This 

effect changed my colours slightly from the 

previous step. Truthfully, this was something 

I’ve never done before; I enjoyed the look I was 

getting and decided to keep it. Don’t be afraid 

to experiment with some of the tools to see 

what they can do, but be careful to not abuse 

the computer. I feel that digital paintings look best when they’re not so 

obviously digitally created. That’s my preference anyway. 

The painting was almost finished here and I felt once more that the 

composition could be better. So I selected my Crop tool and cropped a bit 

off the right side of the painting. For the final finishing touch, I wanted to 

add some noise and additional texture to the painting, so I selected a mid-

tone grey, created a new layer and filled that layer with grey, making sure 

this layer was on the very top. I then selected Noise in the Filter menu and 

chose Add Noise. When using this tool you’ll need to adjust the settings 

until they look good to you. I then selected Blur More in the Blur settings. 

I did this to soften the texture of the noise a bit. And finally, I changed my 

layer to Soft Light and brought the Opacity down to about 17% (Fig.09).  

Final Thoughts
Well, that’s it. Remember to have fun. Sketch, draw and paint from life as 

much as you can. Keep it simple. If you look at the design of my portrait 

you can see that my shapes and forms are basic and simple. When I 

combine strong values and colour to my basic design, the final appears 

more complicated than it really is.       
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Jason Seiler
For more from this artist visit:

http://www.jasonseiler.com

Or contact them at:

jseiler@jpusa.org
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“I find that it’s much 
easier to get a unified 
colour scheme using 
larger brushes, rather 
than smaller ones.”

Yang Xueguo, painter of the surreal and the fantastical, gives us not only a wonderful 

insight into the creation of his image, Concrete 7, but also kindly shares with us his 

very own “Good Brush Set”, which he used exclusively to paint this piece in Photoshop.
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Moving on, I adjusted the whole image’s colour 

tone to something close to yellow, choosing 

“Good Brush #5” to paint the main colours and 

add contrast. Good Brush #5 can easily paint 

the strokes with a blocky feel, which is very 

helpful when building up detail. At this stage I 

had to be sure not to forget to add some cool 

colours to the base warm colour, just to make 

the colour tone richer and give more variety to 

the image as a whole (Fig.03).

Here I used the small brushes to add some 

detail; I always use Good Brush #5 and my 

textured brushes to easily paint textures and 

shapes. I gave the image two lighting scenarios, 

with one light being directed from the top, and 

Created In:
Photoshop

This image was painted with Adobe Photoshop 

using my “Good Brush Set”, which you can 

download for free with this article. To start 

things off, I began by drawing a simple sketch 

on paper with the ideas I had in mind. The most 

important things were the design of the layout 

and the basic shapes, being sure to leave some 

empty space on the paper. Usually, ideas do not 

always look great in just a single minute; it takes 

some time (Fig.01). 

I continued by scanning the sketch drawn on 

paper into Photoshop. Starting work on the 

image digitally, I began by adding a new layer 

above it and filling it with a dark red colour, 

and then painted some basic colour tones and 

contrast with a large brush. I find that it’s much 

easier to get a unified colour scheme using 

larger brushes, rather than smaller ones. I then 

added some light and dark areas, using my 

“Good Brushes” #1 to #6 (Fig.02).

http://www.2dartistmag.com
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the second from the back. All of the shadows in 

the image were dependent upon the direction of 

these two light sources (Fig.04).

You can use reference photos to help you paint 

detailed textures and shading, but be careful not 

to miss out the smaller shapes in your image, 

as every object has its own structure, even the 

smallest. At this stage of painting I’m using my 

texture brush to paint (Fig.05). 

The most important step here is colour blending, 

and I have made some colour blending smudge 

tools in my Good Brush Set which you can 

check out when you download the brush pack 

with this article. You can use these to easily 

blend the transition between your colours. Using 

this method, the rough strokes will be smoothed 

easily and quickly (Fig.06).

Here I used the “FX Brush” to fade the shapes 

away from the eyes, which was a good way to 

define the levels of the scene, and to enhance 

the atmospheric and optical effects. Using the 

“Glow Brush” I then added some bright areas to 

strengthen the expression of the image, paying 

“The most important step here is 
colour blending”
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page 117www.2dartistmag.com Issue 043 July 2009

Concrete 7 Making Of

attention not to forget to switch the brush’s 

mode to Screen or Color Dodge to give it a 

lightening effect (Fig.07).

Using the “Smoke Brush” or “Fog Brush” I 

painted in some smoke effects, because without 

this I felt the image would look too still. Using 

the FX Brush we can easily add large effects to 

an image, such as light, energy, magic, and so 

on. This is a particularly good way to make the 

image look more extensive (Fig.08).

Finally, using the Levels tool, I adjusted the 

colour and contrast of the image. Another way 

of adjusting the colour is to add a new solid 

colour layer and changing the blending mode to 

Overlay. This can adjust both contrast and tone 

at the same time (Fig.09).

And here is the finished image (Fig.10). 

Hopefully you will have found the breakdown of 

my workflow for this image useful, and I hope 

you will enjoy using my Good Brush Set. Thanks 

for reading! 

Note from the Editor: The Good Brush Set 

which you can download with this tutorial has 

kindly been provided by Yang Xueguo for your 

personal use.  you may use the brushes for any  

free or commercial projects.

Yang Xueguo
For more from this artist visit:

http://hi.baidu.com/blur1977/ 

Or contact them at: 

blur1977@126.com

“This can adjust both contrast 
and tone at the same time”

http://www.2dartistmag.com
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Alex Heath is an artist in the UK 

who uses Photoshop, cups of tea, 

wire wool and tile grouting to create 

his horror game inspired artworks. 

Find out how a teabag and a bit 

of paper were used to help in the 

rendering process of his image, 

Gross Worm.

“I find working 
in greyscale for 

concepts a much 
quicker and cleaner 
process – something 

I learnt the hard 
way!”
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So once the five-minute scribble was down 

I could then assess what I had against the 

concept I originally outlined, to see if it would fit 

with what I had planned to draw. So far so good! 

The worm-like body is representative of Medusa 

and the Gorgon sisters, recognisable monster 

figures; this coupled with the juxtaposition of the 

women joined to the monster looked just like the 

kind of creature I was after!

The sketch had some anatomy issues, 

especially the woman host as she was a bit 

disproportionate at this stage. This is something 

I would normally fix at this part of the image 

creation process if the image was going to take 

many, many hours of work. I decided, however, 

to only spend about 2 to 3 hours on the image 

and approach it as a creature concept, so I 

figured I would simply fix the issues whilst I 

rendered, as the sketch was acting more of a 

guide than a definitive design in this instance. 

Values
When I work on creature and character 

concepts I generally block out values and details 

in many passes of greyscale (Fig.02). With each 

pass I decreased my brush size and added 

more detail, building up layers of underpainting 

and playing with design options. The brush I 

tend to use for this type of refining is a Standard 

Hard Round brush, with Opacity set to about 

70% and Flow to 50%. I used this brush and 

the Eyedropper tool to blend my values. I find 

this process very quick, allowing me to change 

the design at will and to try out many options 

(Fig.03).

Later on during the process of refining forms 

and values, I started to fix the issues I had with 

the anatomy. As mentioned, this is very quick 

to do when working in greyscale; it doesn’t 

take long to sort out (Fig.04). For the very last 

stage of the refinement process I used different 

brushes to start adding texture in order to 

Created In:
 Photoshop

Concept
When I sat down to create this image I had a 

rough idea of what I wanted to show. Having 

played many games of the survival horror genre 

recently, namely Dead Space and Silent Hill, I 

decided I wanted to paint a creature that would 

be right at home in this kind of environment. I 

wanted the image to have a disturbing feel to it, 

something that plays on the viewer’s mind, and I 

have found that a good way to achieve this kind 

of unease is to mix beauty and innocence with 

something horrible and scary; the juxtaposition 

of the two generally causes the viewer to ask 

questions and feel uneasy about the creature. It 

sounds horrible; however, for the type of genre 

it’s for, it’s actually quite fitting!

The Sketch
I generally start a new artwork with a quick 

five-minute sketch to get down what I can see 

in my mind’s eye. I tend to use line at this stage 

of the process, rather than blocking in values 

to make silhouettes, as I find line easier to 

understand when trying to get an idea down 

quickly (Fig.01).

“The suggestion of details in this 
type of image works to great 

effect”
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suggest details. I used custom brushes to add a 

skeletal look to the tail end (Fig.05), and a brush 

that I normally use for painting hair to sculpt the 

form on the tail’s tentacles (Fig.06). 

I find that the suggestion of details in this type 

of image works to great effect; the mind fills in 

the gaps and makes the image appear more 

detailed than it is, which is something I have 

learned from studying other artists’ work. I am 

learning to effectively use this technique in my 

own art.

Colour & Texture
Once I felt there was enough detail and the 

forms were reading correctly, I flattened the 

image (it was about eight layers at this point). I 

then added a new layer, set it to Overlay, and 

using a Soft Round brush I started to block in 

colour over the greyscale painting (Fig.07). The 

wonderful thing about Overlay layers is that you 

can try out many different colour schemes and 

textures very quickly, without destroying the 

image, which is why I find working in greyscale 

for concepts a much quicker and cleaner 

process – something I learnt the hard way!

Choosing the colours was something of an 

experiment. I had in mind that I wanted the 

woman to look pale and dead, almost rotting, as 

she is just the host for the mutation that is the 

creature. This adds a small storytelling element 

to the character, making it more intriguing and 

frightening. The creature itself has the colours 

of dried blood and internal organs, to both 

show that it’s alive as well as to bring out the 

skin tension and overall grotesque nature of it 

(Fig.08).

“I made a cup of tea and 
slammed the teabag on a sheet of 

white paper”
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For the finishing touches I decided to make 

a new custom brush. I wanted to make some 

splatters to help convey some gore, but also 

to sell the slimy, wet body of the creature. To 

do this, I made a cup of tea and slammed the 

teabag on a sheet of white paper, took some 

photos of the spatters, and then took them into 

Photoshop to turn into brushes. This gave me a 

more natural spatter pattern – and was also a lot 

more fun than searching the internet for blood 

spatter and not getting the images I wanted!

Background
When I felt that the creature was coloured 

and textured to a standard I was happy with, I 

decided to add a quick background to help aid 

the creature. Again, if this image was a proper 

illustration I would have been working up the 

background as I went along and spent many 

hours on it, but as this was a creature concept I 

decided to work this way round instead, as the background was only used 

to add some semantics.

I used the Quick Mask Mode in Photoshop to protect the creature, and 

started using custom brushes to flesh out some suggested detail in the 

background. The brushes I was using here were made from photos of wire 

wool and tile grouting, just playing around with colours and not thinking 

too hard (Fig.09). I mirrored colours and used the spatter brush I made 

earlier on the background, helping to tie the creature to the background 

and stopping it from looking stuck on top (Fig.10).

I added some lighting on a new layer to give the image some depth. This 

technique of volumetric lighting is great to add both depth and to suggest 

a dark and un-inhabitable environment; this technique is used a lot in 

games like Silent Hill (Fig.11). To finish up the background I took the 

mask off and added some lighting, tidying up the edges to include the 

creature in the background. This process took about five minutes, but 

really helped to sell the concept.

Finally, I flattened the image once more and went to Layer > New 

Adjustment Layer > Color Balance. This is an awesome tool which allows 

you to change the highlights, midtones and shadows independently. I use 

this technique a fair amount when producing this type of work; again, it’s 

just experimenting and seeing what looks best. I decided that a cooler 

light source and colder colours in the shadows made the image look a 

lot scarier, and gave the background some more punch. And voilà! She’s 

finished (Fig.12).
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Alex Heath
For more from this artist visit:

Online Sketchbook: http://www.conceptart.org/

forums/showthread.php?t=142378&page=5

Or contact them at:

heath.himself@gmail.com
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Introduction: 
The ‘Digital Art Masters: volume 1’ book, is 

a collection of work from artists which 

have featured in the gallery of 3DTotal. 

Spread over 192 pages, the book features 

some of the finest digital 2D and 3D art-

work that you can see today, from artist 

as Natascha Roeoesli, Philip Straub, Rob 

Chang, Jesse Sandifer, PiSONG, Meny Hilsen-

rad and Ryan Lim and many more. More 

than just any other gallery book, each 

artist has written a breakdown overview, 

each with supporting imagery of how they 

made there piece of work.

for more products in our range visit http://www.3dtotal.com/shop

The first book in the “Digital Art Masters” series, 
contains work by the following artists: 

André Holzmeister, Andrey Yamkovoy, Balazs Kiss, Cetin Tuker, Daniele Montel-

la, d’Ettorre Olivier-Thomas, Donald Phan, Drazenka Kimpel, Egil Paulsen, Eric 

Wilkerson, Fabricio Micheli, Francisco Ferriz, Fred Bastide, Fredrik Alfredsson, 

Haure Sebastien, Jesse Sandifer, Jorge Adorni, Juan J. González, Juliano Castro, 

Khalid Abdulla Al-Muharraqi, Landis Fields, Laurent Gaumer, Laurent Ménabé, 

Li Suli, Linda Tso, Marcel Baumann, Marco Siegel, Mariska Vos, Meny, Hilsenrad, 

Natascha Roeoesli, Nicolas Richelet, Niels Sinke, Norbert Fuchs, Olli Sorjonen, 

Omar Sarmiento, Patrick Beaulieu, Philip Straub, PiSONG, Richard Tilbury, Rob 

Adams, Robert Chang, Romain Côte, Ronnie Olsthoorn, Rudolf Herczog, Ryan 

Lim, Siku and Thierry Canon

: volume 1

http://www.3dtotal.com/damv1


With the release of 3DTotal’s new book, 

Digital Art Masters: Volume 3, we have 

some exclusive chapters for you...

 This book is more than just an artwork 

book. Not only does it feature 

full-colour, full-page images, but each 

artist has given a detailed description, in 

their own words, of the creation process 

behind each piece of published artwork. 

And they’ve done it especially for 

this book! 

This month we feature:

 

“The Machine”  
by Matt Dixon  



The following shots of the “The Machine” book pages are featured here in full-resolution and can be read by zooming in...

2DArtist readers can purchase 
Digital Art Masters: Volume 1, 2 & 3 with a special 20% Discount 

To claim your discount simply purchase here: 

http://www.3dtotal.com/books/

(Note: if a security dialogue box appears, tick ‘Remember’, then click ‘Allow’)



page 128www.2dartistmag.com Issue 043 July 2009

About us 3DTotal

Is a resource website for the CG community; 

amongst our growing number of products for CG 

artists, we produce two monthly downloadable 

PDF magazines – 2DArtist and 3DCreative. 

We are based in the West Midlands, in the UK, 

and our intention with our magazines is to make 

each issue as full of great articles, images, 

interviews and tutorials as possible. If you 

would like more information on 3DTotal or our 

magazines, or if you have a question for one our 

team, please use the links below.

Contact Information
http://www.3dtotal.com

http://www.3dcreativemag.com

http://www.2dartistmag.com

Editor & Content Manager > Lynette Clee 

lynette@3dtotal.com 

Lead Designer > Chris Perrins 

chrisp@3dtotal.com 

Marketing > Jo Hargreaves

jo@3dtotal.com

Partners
If you have a CG community website and would 

like to support 3DCreative and/or 2DArtist 

magazine by showing our banners, please 

contact Lynette Clee at the email address above
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